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Safety summary

The following general safety precautions must be observed during all phases of
operation, service and repair of this equipment.

Failure to comply with these precautions or with specific warnings elsewhere in this
manual violates safety standards of design, manufacture and intended use of the
equipment. Thrane & Thrane A/S assume no liability for the customer's failure to
comply with these requirements.

Do not operate in an explosive atmosphere

Do not operate the equipment in the presence of flammable gases or fumes.
Operation of any electrical equipment in such an environment constitutes a definite
safety hazard.

Keep away from live circuits

Operating personnel must not remove equipment covers. Component replacement
and internal adjustment must be made by qualified maintenance personnel. Do not
replace components with the power cable connected. Under certain conditions,
dangerous voltages may exist even with the power cable removed. To avoid injuries,
always disconnect power and discharge circuits before touching them.

Do not service alone
Do not attempt internal service or adjustments unless another person, capable of
rendering first aid resuscitation, is present.

Do not substitute parts or modify equipment
Because of the danger of introducing additional hazards, do not substitute parts or
perform any unauthorized modification to the equipment.

Keep away from active antenna front

This device emits radio frequency energy when switched on. To
avoid injury, keep a minimum safety distance of 0.6 m from the
antenna front when the EXPLORER™ 500 is on. See also the
below section Antenna safety instructions.

()
NG

0.6 METRES

Only use approved batteries from Thrane & Thrane

Use of non approved batteries may result in explosion, fire, electrical shock or injury.

Observe marked areas

Under extreme heat conditions do not touch areas of the

EXPLORER™ 500 that are marked with this symbol, as it may sss
result in injury.
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Antenna safety instructions

Antenna safety instructions

Use only manufacturer supplied antennas
Antenna minimum safe distance: 60 cm

Antenna gain

Directional, with maximum gain of 11.1 dB reference to isotropic.

The Federal Communications Commission has adopted a safety standard for human exposure to RF (Radio
Frequency) energy which is below the OSHA (Occupational Safety and Health Act) limits.

Antenna mounting

The antenna supplied by the manufacturer must be located such that during radio transmission, no person or
persons can come closer than the above indicated minimum safe distance to the antenna, i.e. 60 cm.

To comply with current FCC RF Exposure limits, the antenna must be installed at or exceeding the minimum
safe distance shown above, and in accordance with the requirements of the antenna manufacturer or
supplier.

Antenna substitution

Do not substitute any antenna for the models supplied or recommended by the manufacturer. You may be
exposing people to excess radio frequency radiation. You may contact the manufacturer for further
instructions.

Radiation warning

WARNING! Maintain a separation distance of at least 60 cm from the front face of the
A antenna to a person.

You, as the qualified end-user of this radio device, must control the exposure conditions of bystanders to
ensure the minimum separation distance (above) is maintained between the antenna and nearby persons,
for satisfying RF Exposure compliance. The operation of this transmitter must satisfy the requirements of
Occupational/Controlled Exposure Environment, for work-related use. Only use the terminal when persons
are at least the minimum distance from the front face of the antenna.

TT 98-122274-M v



About this manual

About this manual

Intended readers

This manual is a user manual for the EXPLORER™ 500. The readers of the manual include anyone who is
using or intends to use the EXPLORER™ 500. No specific skills are required to operate the EXPLORER™ 500.
However, it is important that you observe all safety requirements listed in the Safety summary and in the
Antenna safety instructions in the beginning of this manual, and operate the EXPLORER™ 500 according to
the guidelines in this manual.

Manual overview

This manual has the following chapters:
»  Introduction contains an overview of the BGAN services and a brief description of the system.

*  Getting started explains how to insert SIM card and battery, start up the unit, and navigate the display
menus. It also contains a short guide to making the first call.

»  Using the display and keypad contains an overview of the display menu system and explains how to use
the menus.

*  Using the interfaces explains how to set up and use each interface.

»  Using the web interface explains how to use the built-in web interface of the EXPLORER™ 500, and
describes the available menus and settings. It also explains advanced setup of interfaces with the web
interface.

*  Maintenance and troubleshooting contains a short troubleshooting guide and explains how to update
software. It also describes and lists the alarm messages that may appear in the handset, and gives
information on where to get further help if necessary.

Typography
In this manual, typography is used as indicated below:
Bold is used for the following purposes:

*  To emphasize words.
Example: “Do not touch the antenna front during pointing”.

e Toindicate what the user should select in the user interface.
Example: “Select Settings > Interfaces > Bluetooth and click Enabled”.

Italicis used to emphasize the paragraph title in cross-references.
Example: “For further information, see Connecting Cables on page...”.

COURIER is used for the following purposes:

* Toindicate text appearing in the display.
Example: “the Main screen shows READY”.

¢ Toindicate low level commands such as AT commands.
Example: “In your terminal program, type ATD”.
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Chapter 1

Introduction

Welcome

Congratulations on the purchase of your EXPLORER™ 500!

The EXPLORER™ 500 is a broadband mobile terminal with integrated antenna, providing high-
speed data and voice communication via satellite through the Broadband Global Area Network
(BGAN).

Just plug in a phone, fax, laptop or PDA, or use the Bluetooth® interface, point the antenna
towards the BGAN satellite - and you are online.

The flat, light-weight design of the EXPLORER™ 500 makes it easy to carry e.g. in the front pocket
of a laptop bag.

Applications include:

» Internet browsing

e  E-mail

*  Phone and fax services

* Llarge file transfers

* Video conferencing and Streaming

* VPN (Virtual Private Network) access to corporate servers

In this chapter

This chapter gives an overview of the BGAN system and services, and introduces the
EXPLORER™ 500.

It also gives an overview of the physical unit and its features and functions.

TT 98-122274-M 1



Chapter 1: Introduction

The BGAN system

What is BGAN?
The Broadband Global Area Network (BGAN) is a mobile satellite service that offers high-speed

data up to 492 kbps and voice telephony. BGAN enables users to access e-mail, corporate
networks and the Internet, transfer files and make telephone calls.

Coverage

The Inmarsat® BGAN services are based on geostationary satellites situated above the equator.
Each satellite covers a certain area (footprint). The coverage map below shows the footprints of the
BGAN system.

£ T T T T T T T 7 T T T T T T T T —!
s -2 140 [ s ar i ar e o e ar r wr 8 -4 140 It [
. FI 1-4 sacellive F2 1-4 sarellice F1 |- sacellie  The Mo depicts In ks smestaions of coverage. but doesnot whrw.inmarsat.com/bgan
i represent a guarantes ofservics The avalability ofsenioe 2 the
(To be determned) mlge oTooverage ares Tuctuates depending on various monditions
The launch ofthe F-3 satellite will be determined in due course.
)

boo inmarsat

[T | The map depicts Inmarsat's expectations of coverage, but does not represent a
guarantee of service. The availability of service at the edge of coverage areas fluctuates
depending on various conditions.

The launch of the F-3 satellite will be determined in due course.
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Chapter 1: Introduction

Overview of the BGAN system

A complete BGAN system includes the EXPLORER™ 500 with connected peripherals, the BGAN
satellite, and the Satellite Access Station (SAS). The satellites are the connection between your
EXPLORER™ 500 and the SAS, which is the gateway to the worldwide networks (Internet,
telephone network, cellular network, etc.).

Packet Switched Network

@ g&
IP Router

. PC
A '... /
rJ \ ',“.
\ ]
Satellite Access Station
EXPLORER™ 500 (SAS)

Voice and ISDN

Circuit Switched Network

Bluetooth
Lapt
Handset aptop
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Chapter 1: Introduction

The BGAN services

Supported services
This section describes the services available with BGAN. Note that not all of these services are
available in the EXPLORER™ 500. See Features and interfaces of the EXPLORER™ 500 on page 5.
The services currently supported by BGAN comprise:
* A Packet Switched connection to the Internet
* A Circuit Switched (Dialed) connection for voice, fax or data

*  Short Messaging Service (SMS)

Packet data service

The BGAN network supports different classes of data connection to the Internet.

* Using a Standard data connection, several users can share the data connection
simultaneously. This type of connection is ideal for e-mail, file transfer, and Internet and
intranet access. The user pays for the amount of data sent and received.

* Using a Streaming data connection, you get an exclusive, high-priority connection, ensuring
seamless transfer of data. This type of connection is ideal for time critical applications like live
video over IP. The user pays for the duration of the connection (per minute charge).

Circuit switched (dialed) service

Two types of circuit switched connection are available:

» Standard Voice. A low-tariff connection for voice only. The voice signal is compressed to
4.0 kbps, which reduces the bandwidth use and consequently the tariff.

e 3.1kHz Audio. A high quality connection which can be used for Premium Voice, G3 fax,
analog modem or ISDN.
The signal is uncompressed 3.1 kHz audio, which allows for optimum voice quality.

SMS service

The BGAN system provides a Short Messaging Service (SMS) for sending and receiving SMS
messages.

Supplementary services

The BGAN system also provides the following supplementary services:
* (Call hold

*  Call waiting

* (all forwarding

*  Voice mail

+  Call barring (using AT commands)

TT 98-122274-M 4



Chapter 1: Introduction

Features and interfaces of the EXPLORER™ 500

Features
The EXPLORER™ 500 provides the following features:
B High speed data up to 464 kbps - shared bandwidth
B Support for Streaming classes 32, 64 and 128 kbps
B Simultaneous voice and data
B Standard LAN, USB, Bluetooth and phone/fax ports

B Built-in web interface allowing you to manage your phone book, messages and calls, and
customize the terminal to your specific needs

B 100-240 V AC power adapter

B Lightweight and portable design
B Easy setup and use

B Robust and durable design

B CE, FCC and GMPCS certified

TT 98-122274-M 5



Chapter 1: Introduction

Overview of interfaces

The EXPLORER™ 500 provides a number of interfaces for connection of various types of
computers, fax devices and phones.

Bluetooth

— | ———
' / Bluetooth

Handset

USB or LAN

Standard Phone Standard Phone
Connection Connection

Using the interfaces on page 47 describes how to use each of the available interfaces.
Minimizing power consumption

The EXPLORER™ 500 is designed for minimum power consumption. This means that functions that

are not currently used will automatically go into a “sleep mode” to minimize the power
consumption.

In addition to this automatic sleep mode function, you can disable each of the interfaces if they are
not currently used. Note, however, that you will not be able to use these interfaces until you

enable them again. For information on how to enable/disable interfaces, see Enabling or disabling
an interface on page 49.

TT 98-122274-M



Chapter 1: Introduction

Your EXPLORER™ 500 terminal

Overview

The EXPLORER™ 500 is a compact unit comprising antenna, compass, display and keypad, all in
one unit.

Display and keypad

The EXPLORER™ 500 has a display and a keypad for displaying status and for changing simple
parameters.

Power indicator

Message indicator

BT «& & B
ﬁ READY 5
|y | ]
Keypad

Power Button Display

For information on how to use the keypad and display, and for an overview of the display menu
system, see Using the display and keypad on page 30.

TT 98-122274-M 1



Chapter 1: Introduction

Light indicators

The EXPLORER™ 500 has two light indicators next to the display: a green power indicator and a
red message indicator.

Green Power indicator
The function of the green Power indicator to the left of the display is as follows:

Behavior of green indicator Meaning

Short flash every 2 seconds The EXPLORER™ 500 is on.

Steady light The battery is charging.

Flashing rapidly A charging error has occurred.
For further information, refer to the Troubleshooting Guide on
page 128.

off No power or Stealth mode.

Red Message indicator
The function of the red Message indicator is as follows:

Behavior of red indicator Meaning

Flashing An alarm is active or
An SMS message has arrived.

Press OK on the keypad to view the alarm(s) or SMS
message(s).?

The red light will keep flashing after OK is pressed if
* there are more SMS messages, or

* analarm is still active.
For information on alarm messages, see Alarm messages
on page 135.

off No messages are present, or the EXPLORER™ 500 is in Stealth
mode.

a. If a computer is connected, you can also view alarms and SMS messages in the built-in web interface in the
EXPLORER™ 500. For further information, see Icons in the icon bar on page 77.
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User interfaces

The keypad and display are used for pointing the antenna, for displaying status and for changing
simple parameters.

To obtain full access to all features and for ease-of-use, you should use a computer
(a PC, Laptop or similar) and one of the following:

*  The web interface. A built-in web interface for easy configuration and daily use. The web
interface is accessed from a computer connected to the EXPLORER™ 500, using an Internet
browser. For further information, see Chapter 5, Using the web interface.

*  The BGAN LaunchPad from Inmarsat. BGAN LaunchPad is a computer application used to
control terminals in the BGAN system. LaunchPad is provided on the Inmarsat BGAN CD-ROM
supplied with your EXPLORER™ 500. For information on how to use the LaunchPad, refer to
the manual on the Inmarsat CD-ROM.

Additionally, it is possible to control the EXPLORER™ 500 using AT Commands. Refer to
Appendix B, AT commands.

Antenna
The white part of the EXPLORER™ 500 is the antenna module. The antenna module comprises a
GPS (Global Positioning System) antenna, a BGAN antenna and a Bluetooth antenna.
Compass
The EXPLORER™ 500 also provides a compass to help positioning the
antenna. For further information on how to use the compass, see
Pointing the antenna on page 21.
Battery
The EXPLORER™ 500 comes with a rechargeable battery, which is easily inserted. The battery is
automatically recharged when power is applied to the EXPLORER™ 500. Steady green light
indicates that the battery is charging.
SIM card

The SIM (Subscriber Identity Module) card used for the EXPLORER™ 500 is a standard SIM card,
which is acquired from the Airtime Provider.

The EXPLORER™ 500 requires a SIM card to go online and to access the settings of the
EXPLORER™ 500. Without a SIM card you can only see the Main screen of the display system
showing battery status etc. Using the web interface, you can view the properties of the
EXPLORER™ 500 and upload software without inserting a SIM card. Upload of software, however,
requires an Administrator user name and password.
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Matrix of services and communication interfaces

The following table shows which services can be accessed from which interfaces, and which types
of equipment can be used.

Interface on the EXPLORER™ 500

Service Display/
Phone/Fax Bluetooth USB LAN
Keypad
Analog Bluetooth
S| 3.1kHz telephone handset
'§ Audio
= G3 Fax machine
S
-}
£| Standard | Analog Bluetooth
£ Voice telephone handset
wv
§ Computer with Computer Computer
(= Data analog modem (64 kbps
uDI)

S Comput C t
£ Data omputer gr:]lpu er
2| multi-user wit
5 Switch/Hub
(%)
2
< Computer Computer Computer
5 Data
A cingle-
g| single-user
[
&
SMS Computer | Computer | Computer View only

What’s next?

This chapter has provided an overview of the BGAN system and of the EXPLORER™ 500.

The next chapters will go into more detail about how to set up and use the EXPLORER™ 500. The
following chapter, Getting started, explains how to unpack and start up the EXPLORER™ 500, and

how to point the antenna in order to get the best possible signal.

TT 98-122274-M
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Chapter 2

Getting started

In this chapter

This chapter describes:
* whatisincluded in the delivery,
* how toinsert and remove the battery and SIM card, and

*  how to start up the EXPLORER™ 500 and make the first call or data session.

Unpacking and assembling

Unpacking

Getting Started Kit

Unpack the EXPLORER™ 500 and accessories and check that the following items are present:
containing:
- Getting Started leaflet

- Quick Guide

EXPLORER™ 500 - EXPLORER™ 500 CD-ROM

- BGAN LaunchPad CD-ROM

AC/DC adapter

I USB Cable

EXPLORER™ 500 Battery

LAN Cable
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Inserting the SIM card

The EXPLORER™ 500 is delivered with the battery separated from the terminal. If the battery is
already inserted, remove it as described in Removing the battery on page 13.

The SIM card is provided by your Airtime Provider. Insert the SIM card as follows:
1. Insert the SIM card into the SIM slot. Make
sure the SIM card is positioned as shown!

2. Press gently until it clicks.

3. Slide the lock to close the SIM slot.

Inserting the battery

Do as follows:

1. Insert the battery.
Make sure the battery is positioned correctly as
shown.

2. Press gently until it locks.

LT | Before using the terminal the first time: To ensure accurate information on the battery
capacity you should fully charge, then fully discharge the battery (until the

EXPLORER™ 500 closes down automatically), and finally recharge the battery. The
EXPLORER™ 500 can be used during the discharging process, but the remaining battery
capacity may not be displayed correctly.

For information on how to recharge the battery, see Recharging the battery on page 125.
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Removing the battery

To remove the battery, do as follows:

1. Locate the slide lock at the bottom of
the unit.

2. Slide the lock aside to release the
battery from the unit.

3. Remove the battery.
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Removing the SIM card
To remove the SIM card, first remove the battery as described in Removing the battery on page 13.

[T | When the SIM card is removed, you cannot use the display menu system nor make calls
or start data sessions.

Only emergency calls are allowed, and only if permitted by the network.
However, if you have an administrator user name and password, you can upload

software using the web interface. For further information, see Uploading software on
page 112.

Remove the SIM card as follows:

1. Slide the lock aside to open the SIM
slot as shown.

2. Gently press the SIM card and let it
pop out of the slot.

3.  Remove the SIM card.
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Connecting cables

After inserting SIM card and battery, connect all relevant cables.

Connect the cables before making the final adjustment of the antenna position.
Otherwise you may accidently move the antenna when you connect the cables.

Side connector panel

The connector panel is placed on the side of the EXPLORER™ 500 and has the following

connectors:

*  USB connector for data equipment

*  Phone/fax connector for phone, fax or

analog modem
*  LAN connector for data equipment

*  DC Power connector (10-16 V DC) for
connection to a 100-240 V AC/DC
adapter, or to a charger cable which
connects to the cigarette lighter
socket/12 V DCin a car.

“some

USB Phone/fax LAN DC Power

For information on how to connect to a specific interface, see the corresponding section in
Chapter &4, Using the interfaces. The end of this section describes how to connect to power.

Rear connectors

Apart from the connectors in the connector panel, the EXPLORER™ 500 has two connectors placed

on the rear side of the EXPLORER™ 500,

e a connector for the Thrane & Thrane
external antenna, marked ANT and

* aconnector for charging the
EXPLORER™ Bluetooth Handset,
marked DC OUT.

For information on how to connect to these interfaces, see Additional interfaces on page 72.

TT 98-122274-M
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Before connecting to power

You can connect to external power or use the battery delivered with your EXPLORER™ 500.
Refer to Power input on page 143 for specifications and pin-out for the DC Power input.

If you are connecting to a 100-240 V AC electrical outlet, use the AC/DC adapter included with your
EXPLORER™ 500.

Alternatively, you may connectto 12V DCin a car.

Connecting to power

You can connect the DCinput to power without the battery inserted.

If the battery is inserted when you apply power to the EXPLORER™ 500, the battery is
automatically recharged.

Connecting to a 100-240 V AC electrical outlet: Connect the
AC/DC adapter to the DC Power input on the side of the
EXPLORER™ 500. Then connect the power cable between the
100-240 V AC electrical outlet and the AC/DC adapter.

Connecting to 12 V DC in a car: Connect the charger cable between the DC Power input of the
EXPLORER™ 500 and the cigarette lighter socket in the car. A suitable charger cable is available
from Thrane & Thrane.
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Powering the EXPLORER™ 500

Automatic power up

The default behavior of the EXPLORER™ 500 is to power up automatically when you connect the
power cable. If you wish, you can change this power up mode, so that the EXPLORER™ 500 is only
powered if the Power button is pressed.

For further information on power up mode, see Setting the power up mode on page 41 or Power up
behavior on page 93.

Switching the EXPLORER™ 500 on/off

To switch on the EXPLORER™ 500, push  power
the Power button next to the display and  Indicator
hold it down until the green Power

indicator lights up. It normally takes one ~ Power
or two seconds. Button

WARNING! When the EXPLORER™ 500 is powered on, stay clear of the antenna
A front! The antenna emits radio frequency energy, not only when the display shows
DATA ACTIVE. Always keep a minimum distance of 0.6 m from the antenna front.

To switch off the EXPLORER™ 500, push the Power button again and hold it until the display
shows SWITCHING OFF.. ..

After switching on the EXPLORER™ 500 you will be
prompted for a PIN (Personal Identification Number),
unless the PIN is disabled (e.g. using the BGAN
LaunchPad).

ENTER PIN?
CAMNCEL ok

|| | — | -

For information on the options after power on, see the next section.
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Options for the start-up procedure

Overview of the start-up options

You have different options for the start-up procedure. Each of these options are briefly described
in this section.

For information on how to enter PIN and point the antenna, see the subsequent sections.

The following drawing shows the options available after power on.

Power on

ENTER PIN?

Cancel OK

"Signal Strength"
Cancel OK

ENTER PIN

*_

3
"M i " "M ai " "Signal Strength"
You cannot access the You cannot access the 2 1
menu system, and you menu system, and you
cannot use the BGAN cannot use the BGAN "Main screen” "Main screen”
network. network, except for
emergency calls, if | |
allowed by the network.
[ Menu system ] [ Menu system ]
You can access the You can access the
menu system but you menu system and use
cannot use the BGAN the BGAN network.

network.

[T |If the use of PIN is disabled, e.g. from the BGAN LaunchPad, the display sequence is the
same as after successfully entering the PIN. This means that after power on, you will see
the Signal strength screen.

The numbers on the drawing refer to the different start-up options described in the following
sections.
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“Full” procedure (1)

After power on, enter the PIN and then point the antenna.

In this mode you have full access to the EXPLORER™ 500, that is you can use the menu system and
communicate on the BGAN network.

The display will show READY when the menu system is not activated.

“0Off-line” procedure (2)

After power on, enter the PIN, but cancel pointing.

In this mode you can use the menu system, but are not able to communicate on the BGAN
network.

The display will show POINT NOW? when in the Main screen.
Press A or ¥ to enter the menu system.

When you want to point the antenna, press OK from the Main screen.

“Emergency” procedure (3)

After power on, cancel the PIN and then point the antenna.

In this mode you can only place emergency calls, and only if permitted by the network. You are not
able to access the menu system nor to communicate on the BGAN network (apart from emergency
calls), until you enter the PIN.

The display will show ENTER PIN?
If you press OK you can enter the PIN. No other options are available from the keypad.

From the web interface you can view properties and, if you have an administrator password,
upload software.
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Entering the SIM PIN

Overview

You have to enter a PIN to use the EXPLORER™ 500, unless the use of PINs is disabled e.g. from
the BGAN LaunchPad.

The first time you are asked for a PIN, you can choose to cancel (press C). If you cancel, you are
asked again after pointing is completed. At that point you must enter the PIN to be able to
continue.

Entering the PIN

To enter the PIN using the display and keypad, do as follows:

o ENTER PIN e
:

L~ 1|

. ENTER PIN

I ve*

1. When you are asked for a PIN, press OK.

2. Press A or ¥ a number of times until the
first digit is correct.

3. Press OK to go to the next digit.

When OK is pressed, the previous digit is
indicated by a *.

To correct an entered digit, press C to go back and use the A and ¥ buttons again.

4. After entering the last digit with OK, press OK again to apply the PIN.

LT | Atthis point the EXPLORER™ 500 may make a sound. This sound is used for pointing the
antenna. To toggle the pointing sound on/off, press A or V.

For further information on how to use the keypad and display, see Using the display and keypad
on page 30.

You can enter the PIN using a phone or computer connected to the EXPLORER™ 500. For further
information, see Entering the SIM PIN using a phone on page 55 or Entering the SIM PIN in the
web interface on page 78.

Wrong PIN

You have 3 attempts to enter the PIN, before you are asked to enter the PUK (Pin Unblocking Key).
The PUK is supplied with your SIM card.
Enter the PUK followed by a new PIN of your own choice. The PIN must be from 4 to 8 digits long.

[LEELENDY | If you enter a wrong PUK 10 times, the SIM card will no longer be functional, and
you have to contact your Airtime Provider for a new SIM card.
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Pointing the antenna

The importance of pointing

In order to obtain the best possible signal at the lowest
possible cost, it is important that the EXPLORER™ 500 .
antenna is pointed correctly towards the satellite.

The antenna must have a clear line of sight to the J
satellite without any obstacles blocking the signal, and - ___f{
the pointing direction of the antenna should be as / AR

. 1 o
accurate as possible. l

[LEELENDY | Incorrect pointing may result in poor quality of the signal, and in some cases
retransmission may be necessary. This could mean you will be paying more than
necessary for your transmission.

The next sections describe how to point the antenna for the best possible signal.

Pointing data

If the position of the satellite in relation to the EXPLORER™ 500 is known, you can use the
compass to roughly point the antenna in the right direction. If you know the Azimuth and the
Elevation, you can use this data to adjust the antenna.

N =0°

*  The Azimuth is the horizontal rotation angle relative to

North (moving clockwise).
W = 270° E=90°

S =180°
*  The Elevation is the vertical rotation angle relative to

horizontal. This means that an Elevation of 0°
corresponds to the EXPLORER™ 500 being in an upright
position, pointing towards the horizon.

Front of antenna

The compass has 7 lines dividing the Elevation scale into 6
spaces. The space between two lines corresponds to 15°.

The Elevation is measured where the lines meet. This compass
shows an Elevation of 30° (2 spaces up from the first line) and
an Azimuth of 270° (antenna pointing towards West).

LT | The above explanation assumes that the compass shows the exact orientation. Please
take into consideration the possible deviation and variation that can occur, e.g. because
of the geographical location or the presence of magnetic objects.
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Required signal strength

As a rule of thumb, the signal strength should typically be 45 dBHz or more for the
EXPLORER™ 500 to be able to establish a call or data session. However, the required signal
strength can vary depending on a number of factors, such as weather conditions and location.

Do not block the antenna signal with your hands

[LEENEND | When pointing the antenna, do not touch the front of the antenna module. For your
safety, always maintain a distance of minimum 60 c¢m from the front face of the
antenna. Also, if you place your fingers on the antenna you will be blocking the
signal, and the antenna will not work efficiently.

Hold the support bracket and the battery module below the antenna while pointing.

Obtaining a GPS fix

The EXPLORER™ 500 must acquire its own location from the GPS satellites before it can register
on the BGAN network. This is called obtaining a GPS fix.

If the antenna is placed in an open location with a wide view to the sky, the EXPLORER™ 500 will
probably obtain the GPS fix automatically while you are pointing towards the BGAN satellite.
However, if part of the view to the sky is blocked, and/or the Elevation is very low, it may
sometimes be difficult for the GPS antenna to “see” a sufficient number of GPS satellites. In such
circumstances, try the following:

1. Place the antenna flat on an even surface, pointing
straight upwards with a clear view to as much of the
sky as possible.
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2. When the GPS fix is obtained, you can start pointing towards the BGAN satellite.
To see the GPS status, enter the display menu system by pressing A or ¥ and select
PROPERTIES > GPS STATUS. For further information, see Viewing the GPS status on
page 42.

Pointing the antenna towards the satellite

To help you obtain the best possible signal strength, the EXPLORER™ 500 uses a pointing sound
to indicate the signal strength during pointing. The frequency of the tone increases with the signal
strength.

You can toggle the pointing sound on/off by pressing A or ¥on the keypad.

Do as follows to point the antenna:

1. While observing the built-in compass of the
EXPLORER™ 500, rotate the
EXPLORER™ 500 left or right until it points
in the correct horizontal direction, known
as the Azimuth. Refer to Pointing data on
page 21.
Hold the battery module and the support
bracket while moving the antenna. Do not
place your hands on the antenna.

2. Tilt the EXPLORER™ 500 slowly up or down
until it points in the correct vertical direction,
known as the Elevation.

Hold the battery module and the support
bracket while moving the antenna. Do not
place your hands on the antenna.

[T | Make sure all cables are connected before fine adjusting the antenna position. If
you connect cables after the final adjustment of the antenna position, you may
accidently move the antenna.
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(] (]
corceL 49.0 dBHz ok

S 3|

3. After passing the PIN screen, the display
shows the current satellite signal strength. Use
this information to fine-adjust the antenna
position as shown in step 1 and 2.

Remember not to touch the antenna part!

ILEENEND | When fine-adjusting the antenna, the display may take a while to update the
signal strength. Wait a second or two after each move to make sure the display
is updated.

If the right most part of the signal strength bar is grey, it indicates that the level has previously
been higher than the current level.

4. When you have the highest signal strength you

o o

can obtain, press OK on the keypad. .t

cencEL 501 dBHz ok

The EXPLORER™ 500 now tries to establish a connection to the BGAN network.
The display shows the progress as follows:

* SEARCHING:
The EXPLORER™ 500 searches for the network operator. Note that the search procedure
can be very short, so you may not see this text.

* REGISTERING:
The EXPLORER™ 500 is registering itself on the network.
If the GPS position has not yet been acquired at this point, the display will show
NO GPS. For further information, see the Troubleshooting Guide on page 129.

e READY or DATA ACTIVE:
READY means the EXPLORER™ 500 is registered on the network and is ready to go online.
If you have already connected a computer, the display shows DATA ACTIVE instead of
READY.

LBy | The display may show a different text than READY or DATA ACTIVE if there is more
important information to show. For example, the display will show ENTER PIN? if you
pressed C at the first request for a PIN. See also the Troubleshooting Guide on page 129.

CANCEL: If you press Cinstead of OK, you exit the pointing menu and the display shows the Main
screen with the message POINT NOW?.

If the PIN has been accepted, you now have access to the menu system, but you will not be able to
connect to the BGAN network, because the signal strength has not yet been accepted.
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Using an external antenna (fixed installation)

The EXPLORER™ 500 has a connector for attaching an external antenna.
Before using an external antenna with the EXPLORER™ 500, please refer to the Antenna safety
instructions in the beginning of this manual.

[LTELEND | Only use the specified antenna from Thrane & Thrane. The antenna and accessories
for connecting to the EXPLORER™ 500 are listed in Options and accessories on
page 127.

The connector is placed at the back of the EXPLORER™ 500. For further information on the
antenna interface, see the technical specifications in External antenna on page 149.

Using a fixed EXPLORER™ 500 (semi-fixed installation)

You can keep the EXPLORER™ 500 in a fixed position, using the Pole mount kit for
EXPLORER™ 500. See Options and accessories on page 127 for information on type number.

[T | The EXPLORER™ 500 is not suited for permanent outdoor installation. Use an external
antenna if the installation is to be permanent.

Do as follows:

1. Mount the EXPLORER™ 500 on a pole or a
wall, for example using the Pole mount kit.

A size M6 thread fits into the mounting
bush in the back of the EXPLORER™ 500.

2. Start up the EXPLORER™ 500 and point the
antenna as described in Pointing the
antenna on page 21.

3. Accept the signal strength by pressing OK
on the EXPLORER™ 500 keypad.

L. Fasten the EXPLORER™ 500 in the pointed position.

You only have to point the antenna once, when you mount it. Using a computer connected to the
EXPLORER™ 500, you can set up the EXPLORER™ 500 to skip pointing at power up. Refer to
Pointing at power up on page 93.
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Making the first call

Introduction
After connecting cables, entering the PIN and pointing the antenna, you are ready to make or
receive the first call.

The following sections provide a short guide to making calls. For more detailed information, see
Making or receiving a phone call with the EXPLORER™ 500 on page 56.

Making a call from the EXPLORER™ 500

Your phone must be connected to the relevant interface. For further information, see

»  Standard phone: Before connecting to the Phone/Fax interface on page 53

*  Bluetooth handset: Pairing devices in which you can enter a passkey on page 50.

To make a call from a phone connected to the EXPLORER™ 500, dial

00 <country code> <phone number> followed by # or off-hook key (# on analog phones, off-hook

key on Bluetooth handsets).

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an analog phone,
dial 00 4539558800 #

Making a call to the EXPLORER™ 500

To make a call to a phone connected to the EXPLORER™ 500, dial
+870 <Mobile subscriber number>

* +is the prefix used in front of the country code for international calls. This is 00 when calling
from most countries in Europe and from many other countries.

*  Mobile subscriber number: The mobile subscriber number of the EXPLORER™ 500 you are
calling.
If the mobile subscriber numbers of the EXPLORER™ 500 are available on the SIM card, they
are listed in the display menu system of the EXPLORER™ 500 under PROPERTIES >
MOBILE NUMBERS. If they are not available, refer to your airtime subscription.

L%y | There are two voice numbers, one for 3.1 kHz Audio and one for Standard Voice.

Example: If you are calling from Denmark and the mobile subscriber number for 3.1 kHz Audio is
772112345 on your EXPLORER™ 500, and you want to make a call to the
EXPLORER™ 500 using 3.1 kHz Audio, dial 00 870 772112345.
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Making a call from one EXPLORER™ 500 to another EXPLORER™ 500

To make a call from one EXPLORER™ 500 to another EXPLORER™ 500,
dial 00 870 <Mobile subscriber number>.

Receiving a call
To be able to receive a call, the phone must be connected to the correct interface of the
EXPLORER™ 500 (Phone/Fax or Bluetooth).

To be able to receive a call with a Bluetooth handset, the handset must be paired with the
EXPLORER™ 500. For information on how to pair Bluetooth devices, see Bluetooth pairing on
page 50.

LE®» | A connected phone will only ring if the call type is set correctly. For information on call
types, see Selecting the call type on page 51.

You can see unanswered calls in the CALLS menu of the display and the web interface.
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Making the

first data connection (LAN)

Before connecting to the LAN interface

For the LAN (Local Area Network) interface to work without any further setup, the computer must
be set up to obtain an IP address and a DNS server address automatically.
To check these settings on your computer, do as follows (For Windows® XP):

L

From the Start menu, select Connect To > Show All Connections.

Double-click Local Area Connection and click Properties.

Select Internet Protocol (TCP/IP) from the list and click Properties.
Make sure both fields are set to obtain an address automatically.

2%

Internet Protocol (TCP/IP) Properties

General | Alternate Configuration I

“You can get |P zettingz aszigned automatically if your nebwork supports
thiz capability. Othenwvize, you need to azk vour netwark, adminiztrator for
the appropriate IP settings.

* Obtain an IP address automaticalls

—" Use the following IP address:
|F address: I

Subnet mask; I

efault gateway; I

* Obtain DMS server address automatically

—" Use the following DNS server addresses;

Ereferred DS zemer I

alternate DS semen I

Advanced... |

ak I Cancel |
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Connecting to the LAN interface

Do as follows:

L

Connect the LAN cable to the network interface of your computer.
A suitable cable is provided with your EXPLORER™ 500.

Connect the other end of the cable to the LAN
connector on the EXPLORER™ 500. . -m’

Start up and point the EXPLORER™ 500 as described earlier in this chapter.

Power on the computer.

When power up and pointing is completed, check the connection e.qg. by starting your Internet
Browser.

You may have to disable the Proxy server settings in your browser. For further information,
see Browser settings on page 75.

What’s next?

After reading this chapter you should be able to start up the EXPLORER™ 500 and make a simple

data

or voice connection.

The next chapters provide more information on the user interfaces and the setup of the
EXPLORER™ 500. The following chapter, Using the display and keypad, explains the display menu
system, which is the basic tool for setting up the EXPLORER™ 500.
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Using the display and keypad

In this chapter

This chapter describes how to use the built-in display menu system of the EXPLORER™ 500.

It contains an overview of the entire menu system followed by a description of each menu.
It also explains the symbols and messages that may appear in the display, and describes how to
navigate using the keypad.

Menu overview

Main menu

The items of the main menu are:

¢ MESSAGES
shows all incoming SMS messages and allows you to open or delete each message or delete
all messages.

¢ CONNECT
shows a list of the Streaming Profiles that are defined and selected for the LAN interface using
the web interface. The CONNECT menu allows you to start and stop data sessions with the
listed Streaming Profiles.

¢ CALLS
shows missed, received and outgoing calls (Voice only).
* SETTINGS allows you to
* restart the pointing procedure,
* set display backlight and contrast,
* set audio indications on or off,
* enable or disable each interface,
* enable or disable stealth mode (a terminal mode where lights and sound are off),
* set the power up mode, and
* restore settings.
* PROPERTIES shows:
* known and accepted Bluetooth devices,
* GPS status,
* IP address, hardware and software numbers,
* IMEI number, mobile subscriber numbers and voice mail numbers, and
* a list of active alarms.

¢ HELP DESK
shows the phone number to the Airtime Provider, if available.
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For information on how to navigate in the menu system, see Navigating the display and keypad on

page 34.

Menu drawing

The below drawing shows an overview of the menus in the display menu system of the

EXPLORER™ 500.

Start up

PIN Code
(Pointing)

MESSAGES
CONNECT
CALLS
SETTINGS
PROPERTIES
HELP DESK

<message 1>
<message 2>
<message 3>
<message 4>
DELETE ALL

'<streaming profile 1>
<streaming profile 2>
| <streaming profile 3>

OPEN
DELETE MESSAGE

MISSED
RECEIVED
OUTGOING

POINT NOW
DISPLAY

START
STOP

BACKLIGHT

ON

OFF
TIMED
SET LEVEL

CONTRAST

AUDIO INDICATOR
INTERFACES

STEALTH MODE
POWER UP MODE

RESTORE SETTINGS

MANUAL

BLUETOOTH DEVICES
GPS STATUS
TERMINAL

MOBILE NUMBERS
VOICE MAIL NUMBER
kALARM LIST

1 <device>

7 <device>
~————

IP ADDRESS

AUTOMATIC

2 <device>
3 <device>
4 <device>
5 <device>
6 <device>

AUTOMATIC |

2 SECONDS
5 SECONDS
10 SECONDS

LEVEL 1
LEVEL 2
LEVEL 3
LEVEL 4
LEVEL 5
LEVEL 6
LEVEL 7

SET LEVEL

—

HARDWARE
SOFTWARE
IMEI

ENABLED

DISABLED

UNIT SER. NO.
MAIN PCB NO.

PSM PCB NO.
MAC

POINTING —
MESSAGES —
ALARM —

PHONE/FAX |
BLUETOOTH ||
LAN |

LEVEL 1
LEVEL 2
LEVEL 3
LEVEL 4
LEVEL 5
LEVEL 6
LEVEL 7

ON
OFF
ON
OFF

The next section shows an overview of the start-up sequence before entering the menu system.
The menus are further described in the following sections of this chapter.
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Display during start-up

Start-up sequence

There are different options for the start-up procedure. The complete startup procedure is
described in Chapter 2, Getting started.
This section only describes the behavior of the display during normal startup.

o

ENTER PIN? e
CANCEL Ok

L~ 1|

After power on you are asked for a PIN.

o]

O | e

L "

When you press 0K and enter PIN, the signal
strength screen appears.

When you have pointed the antenna and pressed OK to accept the signal strength, the display
shows the progress in the Main screen as follows:

* SEARCHING: The EXPLORER™ 500 is searching for the network operator.

* REGISTERING: The EXPLORER™ 500 is registering itself on the BGAN network.
If the GPS position has not yet been acquired at this point, the display will show
NO GPS. For further information, see the Troubleshooting Guide on page 129.

* READY: The EXPLORER™ 500 is registered on the network and is ready to go online.
If a computer is already connected, the display will show DATA ACTIVE instead of READY.

Main screen

The Main screen is shown after passing the PIN and
pointing screens, and anytime you leave the menu
system.

WBT«%- EE
@ READY =

| s |

The Main screen shows the most important status
of the EXPLORER™ 500 such as battery status,
signal strength, and general status.

The Main screen also shows icons for any interfaces that are turned on. In this example, all
interfaces (Phone/Fax, Bluetooth, USB and LAN) are turned on.
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Display symbols

Apart from the menu text, the display can show various symbols. Below is a list of the possible
symbols with an explanation to each symbol.

Symbol Explanation

The battery charge level.
When the level is too low (below 10%) the icon flashes. Recharge the
battery as soon as possible.

If no battery is inserted, the symbol is not shown in the display.

The battery is charging.

The signal strength.
Minimum two bars are normally required to be able to make a Standard
Voice call.

Phone/Fax interface is on.

&)

Bluetooth interface is on.

o
—

LAN interface is on.

USB interface is on.

Unread message (shown next to the message in the message list)

Read messages (shown next to the message in the message list)

a0 0| § %

The current connection on the BGAN network is not ciphered. Do not
transmit data that requires ciphering.

TT 98-122274-M 33



Chapter 3: Using the display and keypad

Navigating the display and keypad

Navigating with the keypad

The PIN must be entered before you can access the menu system.

temperatures close to -25°C/-13°F the display may even turn black for a moment, e.qg.
when you are scrolling through a menu. After 1-2 seconds with no keypad activity the

LT |In low temperatures the display may respond slowly when a key is pressed. At
display will be readable again.

ﬁ BT o &
READY

[
J
J
i

[}
y ,: EEEROD
[}

*  To access the menu system from the Main screen, press A or V.

*  To move up and down in the current menu, press A or V.

*  To select the current menu item or setting, press OK.

* To escape the current menu/setting and return to the previous level, press C.
* To see the hidden part of long text strings, press P>.

* To move backwards in the menu system, or in long text strings, press 4.

*  To adjust settings, press A and V.

Short-cuts

The following short-cuts are available in the menu system:

*  To exit the menu system, press and hold C for one second. The display returns to the Main
screen.

* To activate/deactivate Stealth mode, Press C+OK.When stealth mode is activated, the display
shows STEALTH ACTIVATED for a moment; then all lights and sounds are turned off.

[E%» | For Stealth mode to be available, it must be enabled in the EXPLORER™ 500. Refer
to Enabling or disabling stealth mode on page 40.

*  To turn Pointing sound on/off, Press A or ¥ from the pointing screen.

This action only applies to the current pointing session. To turn the sound on or off for all pointing
sessions, select
SETTINGS > AUDIO INDICATORS > POINTING and select ON or OFF.
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Display text

When you have not entered the menu system, the Main screen shows the currently most important
information. Refer to Dynamic information in the display on page 45.
CANCEL in the left side of the display means: Press C to cancel the current operation.

OK in the right side of the display means: Press OK to accept the current operation.

The menus

The following sections describe each of the menus in the menu system.

All available settings and status items are explained.

To access the menu system from the main
screen, press A or V.

MW MESSAGES '|
CONNECT

E:;][::;”j

(=]
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Messages menu

Viewing the list of messages

To see the list of SMS messages, enter the menu system and select MESSAGES.

Each message is listed with the name (if known) or the number of the sender.
An unopened folder 7 indicates an unread message and an opened folder F= indicates a read
message.

Use A and ¥ to scroll through the list.

For information on how new messages are presented, see Received messages on page 45.

Opening or deleting received SMS messages

To delete all messages, go to the bottom of the list of messages and select DELETE ALL.

To open or delete one message, do as follows:
1. Inthe MESSAGES list, select the message you want to open or delete and press OK.

2. Then select one of the following:

* OPEN: to open the selected message.
The display shows the time and the message contents. Use A and ¥ to scroll through the
message and details.

* DELETE: to delete the selected message.
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Connect menu

Streaming Profiles

Using the web interface you can define a number of Profiles for data transmission. The Streaming
Profiles defined and selected for the LAN interface appear in the CONNECT menu, and can be
started and stopped using the keypad.

Streaming Profiles are Profiles where the Traffic Class is set to Streaming in the Profiles window of
the web interface.

For information on Profiles, see Using Profiles on page 118.

For information on Streaming, see Standard or Streaming data on page 63.
Starting or stopping a Streaming session
To start or stop a Streaming session on the LAN interface, do as follows:

1. Select CONNECT.

2. Select the Streaming Profile you want to start or stop.
The list only shows Profiles that have been selected for the LAN interface.

For information on how to set up the LAN interface, see Configuring the LAN interface on
page 101.

3. Select START or STOP and confirm.

[LFEREND | When running a Streaming session you are charged for the time you are
connected. An active Streaming session will stay active until you stop it.

You can also start/stop Streaming sessions using the web interface. For further information, see
Setting up and activating a Streaming connection on page 63.
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Calls menu

To see a list of calls or data sessions, do as follows:
1. Select CALLS.

2. Select one of the following:
* MISSED: to see a list of incoming calls that were not answered.
* RECEIVED: to see a list of incoming calls that were answered.
* OUTGOING: to see a list of outgoing calls or data sessions.

[T |Local calls are not registered.

3. Select a call from the list to see details such as time, date and phone number.
If there was an error, the call log shows the cause of the error when possible.

When there are more than 100 calls in the list, the oldest calls are automatically deleted to make
room for new calls.

If you need to preserve the call log, you can export it to a file using the built-in web interface. For
further information, see Exporting the call log on page 84.
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Settings menu

Point now

Important ‘ This function will interrupt any ongoing calls or sessions!

If you need to repoint the antenna, select SETTINGS > POINT NOW.

This will bring you to the Pointing screen, described in Pointing the antenna towards the satellite
on page 23.

Setting the display backlight
To adjust the backlight of the display, do as follows:

1. Select SETTINGS > DISPLAY > BACKLIGHT.
From this menu you can set the backlight of the display.

2. Select one of the following:
* ON: to turn the light on.
* OFF: to turn the light off.

* TIMED: to set how long the light should be on after the last key was pressed (2, 5, 10, 30 or
60 seconds).

* SET LEVEL: to set the level of backlight.

Setting the display contrast
To adjust the contrast of the display, do as follows:

1. Select SETTINGS > DISPLAY > CONTRAST.
From this menu you can set the contrast of the display.

2. Select one of the following:
* SET LEVEL: to set the contrast manually.

* AUTOMATIC: to let the EXPLORER™ 500 automatically adjust the contrast according to
the temperature.
The contrast of the display is affected by the temperature. The EXPLORER™ 500 can
automatically adjust the contrast so that the display looks the same, regardless of changes
in the temperature.
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Turning audio indicators on or off

The EXPLORER™ 500 has audio indicators to indicate an event. You can turn each of these audio
indicators on or off.

1. Select SETTINGS > AUDIO INDICATOR.

2. Select one of the following:
* POINTING: a sound to indicate the signal level during pointing.
* MESSAGES: a sound to indicate that a message has arrived.
* ALARM: a sound to indicate that an alarm is present.

3. Select ON or OFF.

Enabling or disabling interfaces

Each interface (except USB) can be disabled to minimize the power consumption. Specially if the
EXPLORER™ 500 is battery powered, it is a good idea to disable unused interfaces. Do as follows:

1. Select SETTINGS > INTERFACES.

2. Select one of the following interfaces:
* PHONE/FAX
* BLUETOOTH
e LAN

3. Select ON or OFF.

Enabling or disabling stealth mode

When the EXPLORER™ 500 is in stealth mode, all lights and sounds are turned off. You can still
use the EXPLORER™ 500, and the display text is readable.

To enable or disable the use of stealth mode, do as follows:
1. Select SETTINGS > STEALTH MODE.

2. Select one of the following:
¢ ENABLED
¢ DISABLED

[E®» | Enabling stealth mode will not put the EXPLORER™ 500 into stealth mode, it only
enables the use of stealth mode.

*  To activate Stealth mode (after enabling Stealth mode), press C+OK on the keypad.

*  To deactivate Stealth mode, press C+0K again.

TT 98-122274-M 40



Chapter 3: Using the display and keypad

Setting the power up mode

By default, the EXPLORER™ 500 starts up automatically when you apply external power. You can
change this mode, so that you always have to press the Power button to switch on the
EXPLORER™ 500.

To set the power up mode, do as follows:

L

2.

Select SETTINGS > POWER UP MODE.

Select one of the following:

* AUTOMATIC: to have the EXPLORER™ 500 power up automatically when external power
is applied.

* MANUAL: to have the EXPLORER™ 500 power up only when the Power button is pressed.

Restoring settings

You can restore default values for the settings in the SETTINGS menu, except the contrast
setting. The following settings are restored:

Backlight

Audio indicators
Stealth mode
Interfaces enabled

Power up mode

Note that all other settings are left unchanged.

To restore settings, do as follows:

L

2.

Select SETTINGS > RESTORE SETTINGS.

Press OK.
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Properties menu

Viewing known Bluetooth devices

You can view a list of the Bluetooth devices that are paired with the EXPLORER™ 500. The devices

are listed with their Bluetooth names.

The devices in this list can communicate with the EXPLORER™ 500 without any further setup.

To view the list of known Bluetooth devices, select
PROPERTIES > BLUETOOTH DEVICES.

To see details on a specific Bluetooth device, select the device in the list and press OK.

Viewing the GPS status

The display can show the current GPS status.

To view the GPS status, select PROPERTIES > GPS STATUS.

The GPS status screen can vary, depending on the situation.

» Ifthe GPS position has not yet been obtained, the

display shows the status of each of the 16 GPS
satellites as follows:

» Ifthe GPS position is known, the display shows
the GPS position, and whether it is a 2-
dimensional or 3-dimensional position (2D fix or
3D fix).

* In some cases, the BGAN network does not allow
the position to be displayed to the user. If this is
the case, the display may just show GPS
ACQUIRED. This means that the GPS position is
received, but the user is not allowed to see it.
This also applies if the EXPLORER™ 500 is not yet
registered on the BGAN network, but the GPS
position is received.

ACQUIRING GPS
NIRERUOE00000000

| S | j | -

N 55948 E 12931

3D FIX

| i | — -

GPS ACQUIRED

| [ —_ |
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Viewing terminal properties

You can view properties of the EXPLORER™ 500 such as IP address, hardware numbers, software
version and IMEI number. When contacting Support, please include these numbers.

To view the properties, do as follows:
1. Select PROPERTIES > TERMINAL.

2. Select one of the following options:

* IP ADDRESS to see the IP address of the EXPLORER™ 500. This IP address is used to
access the web interface of the EXPLORER™ 500. The web interface is a built-in web server
used to configure and set up the EXPLORER™ 500. For further information on the web
interface, see Using the web interface on page 74.

* HARDWARE to see the serial number, PCB numbers and MAC address of your
EXPLORER™ 500.

* SOFTWARE to see the software version of the EXPLORER™ 500.

* IMEI to see the IMEI number (International Mobile Equipment Identity) of the
EXPLORER™ 500. This is the unique mobile equipment number that identifies your
EXPLORER™ 500. The IMEI number is also printed on the serial number label at the back of
the terminal.

Viewing mobile subscriber numbers

If available on the SIM card, the MOBILE NUMBERS menu lists the mobile subscriber numbers
to use when calling the EXPLORER™ 500.

Ly | There are two voice numbers, one for 3.1 kHz Audio and one for Standard Voice. For
further information, see Selecting the call type on page 51.

To view the mobile subscriber numbers, select PROPERTIES > MOBILE NUMBERS.

If the mobile numbers are not available, the display reads
NO INFORMATION AVAILABLE.

Viewing the voice mail number
The EXPLORER™ 500 informs you of any incoming voice mail through the display and through the
web interface.

The voice mail number is the number you call to hear your incoming voice mail.
If available on the SIM card, the PROPERTIES menu shows the voice mail number.

To view the voice mail number, select
PROPERTIES > VOICE MAIL NUMBER.

If the voice mail number is not available, the display reads
NO INFORMATION AVAILABLE.
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Alarm list
If an error is present in the system, an alarm will be issued. For information on how new alarms
are presented, see Display of alarm messages on page 135.

To view the list of currently active alarms, enter the menu system and select
PROPERTIES > ALARM LIST.

The alarms are listed with their ID numbers.

To see the name and time stamp of the alarm, press OK.
Use A and V¥ to scroll through the name, ID and time stamp. If the text is too long, press OK (P>)
to scroll through the rest of the text.

Help desk

If you need support regarding airtime, you may call the Airtime Provider help desk.
To see the help desk number, select HELP DESK in the menu system.

The display will show the name and phone number of your Airtime Provider, if it is available on
the SIM card.

If the information is not available on the SIM card, you can use the built-in web interface of the
EXPLORER™ 500 to store the help desk name and number. For further information, see Accessing
the Help desk on page 123.
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Dynamic information in the display

Types of display information

Text in the display can be:

* Information of received messages.
e Alarms.

*  Status information.

*  Request for action.

Received messages

Alarms

When messages arrive in your EXPLORER™ 500, the 2 MESSAGES
display indicates the number of new messages that have RECEIVED
arrived, and the red message indicator is flashing.

| | —

The messages can be SMS messages or notification of
voice mail.

» If the message is an SMS message, press OK to view the message.

» If the message is information of voice mail, press OK or C to go back to the Main screen.
The red message indicator will keep flashing until you have collected your voice mail.

*  To hear your voice mail, call the voice mail service number provided by your Airtime Provider.

* To see the voice mail service number, select
PROPERTIES > VOICE MAIL NUMBER

When alarms are issued in your EXPLORER™ 500, the
display indicates the number of new alarms, and the red
message indicator is flashing.

1 ALARM
PENDING

|| e | . | -

To view currently active alarms, press OK. To ignore and continue, press C.
See also:

»  Display of alarm messages on page 135.

* Alarm log on page 140.

» List of alarms on page 136.
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Status information

Status information in the display is normally shown in the lower line of the Main screen.

Examples of status information are: READY, REGISTERING and DATA ACTIVE.

Displaying ongoing transmission

When a call or data session is in progress, the display shows DATA ACTIVE in the Main screen.

WARNING! When the EXPLORER™ 500 is powered on, stay clear of the antenna
A front! The antenna emits radio frequency energy, not only when the display shows
DATA ACTIVE. Always keep a minimum distance of 0.6 m from the antenna front.

Request for action

A request for action, if it is not an alarm, is shown in the lower line of the display. This could be
e.g. POINT NOW? or INSERT SIM.

When the text is a question, press OK to accept.

What’s next?

This chapter has explained how to navigate in the display menu system and how to use it for basic
setup of the EXPLORER™ 500.

The following chapter, Using the interfaces, explains in detail how to set up and use each interface
of the EXPLORER™ 500.
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Chapter 4

Using the interfaces

In this chapter

This chapter describes how to use the interfaces of the EXPLORER™ 500. For each connection type
it describes how to connect cables and the necessary setup to establish a connection.

It does not describe advanced configuration of interfaces. For this type of information, refer to the
“Configuring...” sections for the data interfaces in Chapter 5, Using the web interface.

General

Tools for setup and use

Overview
The display and keypad can be used for simple setup, but for enhanced use and for configuration
of interfaces, you need to connect a computer (PC, laptop or similar).
With a computer and a browser, you can use the following to set up the EXPLORER™ 500:
*  The built-in web interface of the EXPLORER™ 500
*  The BGAN LaunchPad

The web interface of the EXPLORER™ 500
The web interface is a built-in web server for setting up and controlling the EXPLORER™ 500,

using a connected computer with a browser. For information on how to use the web interface, see
Using the web interface on page 74.

The BGAN LaunchPad
BGAN LaunchPad from Inmarsat is a computer application for setting up terminals in the BGAN

system. A CD-ROM with the LaunchPad is included in the delivery. For information on how to use
the LaunchPad, refer to the user guide provided with the LaunchPad.
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Services and interfaces

A variety of services can be accessed from different interfaces on the EXPLORER™ 500.

The following table shows the possible combinations of services and interfaces, and which types of
equipment can be used.

Interface on the EXPLORER™ 500

Service Display/
Phone/Fax Bluetooth USB LAN Keypad
Analog Bluetooth
S| 3.1kHz telephone handset
"g Audio
£ G3 Fax machine
S
<
£| Standard | Analog Bluetooth
E| Voice telephone handset
v
E Computer with Computer Computer
G| Data analog modem (64 kbps
uDI)
s Comput Comput
2 Data omputer gr;]lpu er
2| multi-user witt
s Switch/Hub
(%)
2
< Computer Computer Computer
2 Data
m .
+ | single-user
=
[*]
&
SMS Computer | Computer | Computer View only
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Enabling or disabling an interface

Overview

By default, all interfaces are enabled. However, you can disable the LAN interface, the Bluetooth
interface and/or the Phone/Fax interface in order to minimize the power consumption.

[ Note 2 ‘The USB interface cannot be disabled; it is always enabled.

Using display and keypad
To enable or disable an interface using the display and keypad, do as follows:

1.  Enter the menu system.
From the Main screen, press A or V.

2. Select SETTINGS > INTERFACES.
3. Select the interface you want to enable or disable.

4, Select ON to enable or OFF to disable.

Using web interface
To enable or disable an interface using the web interface, do as follows:

1. Connect a computer. Refer to the relevant section in this chapter, e.q. Connecting to the LAN
interface on page 65.

2. Access the web interface.
For further information, see The web interface on page 74.

3. From the left navigation pane in the web interface, select
SETTINGS > Interfaces.

4, Select Enabled or Disabled next to the relevant interface.
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Bluetooth pairing

What is pairing?

Bluetooth Pairing happens when two Bluetooth enabled devices agree to communicate with one
another. When this happens, the two devices exchange passkeys and join a pair. The pairing
process only takes place the first time the two devices are connected. Once the two devices have
established a pair, they automatically accept communication when one device recognizes the
other device.

Pairing devices in which you can enter a passkey

This section describes how to pair devices in which you can enter a passkey.

LBy | The method for pairing devices may vary depending on your Bluetooth device. Consult
your Bluetooth device documentation for information.

For information on pairing devices with a fixed passkey from your EXPLORER™ 500, see Pairing
Bluetooth devices from the web interface on page 106.

The following procedure presupposes that the EXPLORER™ 500 is configured to be visible to other
Bluetooth devices, and that the Bluetooth interface is turned on. For information on configuration,
see Configuring the Bluetooth interface on page 104.

Do as follows to pair the devices:

1. Start up the EXPLORER™ 500.
For further information, see Getting started on page 11.

2. Turn on Bluetooth on your Bluetooth device and place it close to the EXPLORER™ 500.

3. On your Bluetooth device, search for new devices and select the EXPLORER™ 500 when it is
found.
The default Bluetooth name of the EXPLORER™ 500 is EXPLORER 500.
If there is more than one EXPLORER™ 500 in the list, you can use the MAC address to locate
the correct one. To see the MAC address of your EXPLORER™ 500, enter the display menu
system and select PROPERTIES > TERMINAL > HARDWARE > MAC.

4. On your Bluetooth device, enter the passkey of your EXPLORER™ 500.
The default passkey is the serial number of your EXPLORER™ 500. To see the serial number,
look at the label on the back of your EXPLORER™ 500, or enter the menu system and select
PROPERTIES > TERMINAL > HARDWARE > UNIT SER. NO.

The new device is now paired and ready to communicate with the EXPLORER™ 500.
LB | Maximum 7 devices can be paired with the EXPLORER™ 500. If you have already paired 7

devices you have to unpair a device before you can pair a new one. For information on
how to unpair devices, see Unpairing devices on page 108.
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Using a phone or fax machine

Selecting the call type

Definition

The phone connection can be either a Standard Voice connection or a 3.1 kHz Audio connection.
In the web interface you can set up which type of connection to use by default when you make or
receive a call from the Phone/Fax or Bluetooth interface.

When connecting a fax or a modem you must use 3.1 kHz Audio.
Example: If you always have a fax connected to the Phone/Fax interface you can set this interface

to 3.1kHz Audio only. This will mean that if an incoming Standard Voice call is received,
the Phone/Fax interface will not ring.

Selecting the default outgoing call type
To select the default call type for outgoing calls, first connect a computer. Refer to the relevant
section in this chapter, e.g. Connecting to the LAN interface on page 65.

Then do as follows:

1. Access the web interface.
For further information, see The web interface on page 74.

2. Select SETTINGS > Interfaces.
3. Select Phone/Fax or Bluetooth.

4. At Outgoing calls, select Standard or 3.1 kHz Audio.

Up to 7 Bluetooth devices can be paired with the EXPLORER™ 500. Remember to set the call
type for each paired handset in the BLUETOOTH VOICE DEVICES list.

Overriding the default outgoing call type

To override the default setting for a specific outgoing call, do as follows:

¢ To use Standard Voice for the call,
dial 1* before the number.

¢ To use 3.1 kHz Audio for the call,
dial 2* before the number.

Example: To make a call to Thrane & Thrane in Denmark (+45 39558800), forcing the connection

to use Standard Voice, dial 1* 0045 39558800 followed by # if calling from an analog
phone, or off-hook key if calling from a Bluetooth handset.

LB | This will not change the default call type, only the type used for the ongoing call.
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Phone numbers for incoming 3.1 kHz Audio and Standard Voice

3.1kHz Audio and Standard Voice have separate phone numbers. This way, a person calling a
phone connected to the EXPLORER™ 500 can select whether to use 3.1 kHz Audio or Standard
Voice, simply by using one of the two phone numbers.

LY | The call type you are using must be selected in the web interface (refer to the next
section).

If the Mobile subscriber numbers are available on the SIM card you can look them up, using either
the display menu system or the web interface.

To view the phone numbers for Standard Voice and 3.1 kHz Audio, do one of the following:
* Select PROPERTIES > MOBILE NUMBERS in the display menu system, or

e access the web interface and select PROPERTIES. The numbers are listed in the field Mobile
subscriber numbers. For further information, see The web interface on page 74.

If the numbers are not available in the display menus nor the web interface, refer to your airtime
subscription.

For information on how to make a call to the EXPLORER™ 500, see Making a call to the
EXPLORER™ 500 on page 57.

Selecting the incoming call type

To select which call types are accepted for an incoming call, first connect a computer. Refer to the
relevant section in this chapter, e.g. Connecting to the LAN interface on page 65.

Then do as follows:

1. Access the web interface.
For further information, see The web interface on page 74.

2. Select SETTINGS > Interfaces.
3. Select Phone/Fax or Bluetooth.

4. At Incoming Calls, check Standard or 3.1 kHz Audio or both. For Bluetooth, remember to set
the call type for each handset in the BLUETOOTH VOICE DEVICES list.
If the call type used for a call to the EXPLORER™ 500 is not selected in the web interface, the
connected phone will not ring.
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Connecting an analog phone or a fax machine

Before connecting to the Phone/Fax interface

To connect a phone or a fax machine to the Phone/Fax connector, you need an analog telephone
cable with an RJ-11 connector. For specifications and pin-out, refer to Phone/Fax interface on
page 144,

Connecting to the Phone/Fax interface

Do as follows:

L

2.

Connect the cable to your phone or fax machine.
Connect the other end of the cable to the Phone/Fax
connector on the EXPLORER™ 500. " Im -’h

Power up the EXPLORER™ 500 and point the antenna as described in Pointing the antenna on
page 21.

Check the connection by making a phone call or sending a fax.
See Making or receiving a phone call with the EXPLORER™ 500 on page 56 or Sending or
receiving a fax message on page 61.

If connection fails, check that the interface is enabled in the EXPLORER™ 500.

If the analog phone icon is not present in the display Main screen and in the Home window of the
web interface, the interface is disabled.

See Enabling or disabling an interface on page 49.

If the interface is enabled, but connection fails, refer to the Troubleshooting Guide on page 131.
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Connecting a Bluetooth handset

Before connecting a Bluetooth handset
To use a Bluetooth handset with the EXPLORER™ 500, you first have to pair the two devices.
For information on pairing devices, see Bluetooth pairing on page 50.

The Bluetooth handset must be placed within a maximum distance of 100 m from the
EXPLORER™ 500. Note that this is the maximum distance in open air; the actual maximum
distance may be shorter, depending on the environment. In an office environment, you should be
able to establish a connection across the adjoining 2-3 rooms.

Connecting a paired Bluetooth handset
This section does not describe configuration of the Bluetooth interface. For information on
configuration, see Configuring the Bluetooth interface on page 104.

If the devices are already paired, do as follows to connect:
1. Power up the handset and the EXPLORER™ 500.
2. Place the handset close to the EXPLORER™ 500.

3. Turn on Bluetooth on your device.
The Bluetooth connection should now be established, and you are ready to make a call.

LB | Maximum 7 devices can be connected at the same time.

If connection fails, check that the interface is enabled in the EXPLORER™ 500.

If the Bluetooth icon is not present in the display Main screen and in the Home window of the web
interface, the interface is disabled.

See Enabling or disabling an interface on page 49.

If the interface is enabled, but connection fails, refer to the Troubleshooting Guide on page 132.

For information on how to make and receive calls, see Making or receiving a phone call with the
EXPLORER™ 500 on page 56.
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Entering the SIM PIN using a phone

Entering the PIN
If you have a phone connected to the EXPLORER™ 500, you can use it to enter the PIN at start up,
as an alternative to the keypad.

When the EXPLORER™ 500 is waiting for a PIN, you will hear 2 beeps - pause - 2 beeps - etc. in
your phone.

You simply dial the PIN the same way you would dial a phone number:

*  For an analog phone, take the phone off hook and dial <PIN> followed by #. When you hear a
“busy” tone or a dialing tone, the PIN has been accepted and you can put the phone back on
hook.

*  For a Bluetooth handset, dial <PIN> and press off hook key. When you hear a “busy” tone or a
dialing tone, the PIN has been accepted and you can press the on hook key or dial a number.

Wrong PIN
If, instead of the busy tone or dialing tone, you continue to hear 2 beeps - pause - 2 beeps - etc., it
means the PIN was wrong. Check that you have the correct PIN and try again.

If a wrong PIN has been entered three times, you will hear 3 beeps - pause - 3 beeps - etc. This
means you have to enter the PUK (PIN Unblocking Key) provided with your SIM card.
After entering the PUK, you must enter a new PIN of your own choice (4 to 8 digits long).

Dial the following:
<PUK> * <New PIN> * <New PIN> followed by # or off-hook key.

Example: If the PUK is 87654321 and the new PIN is 1234, dial
87654321 * 1234 * 1234 followed by # or off-hook key.

If you enter 10 wrong PUKs, the SIM card will no longer be functional. Contact your Airtime
Provider for a new SIM card.
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Making or receiving a phone call with the EXPLORER™ 500

Analog phone or Bluetooth handset

First connect your phone to the relevant interface. For further information, see Before connecting
to the Phone/Fax interface on page 53, or, for the Bluetooth handset, Pairing devices in which you
can enter a passkey on page 50.

LY | There are different methods for activating a call, depending on the type of phone:
*  Analog phone: Dial # after the number.

*  Bluetooth handset: Press the off-hook key after the number.

Making a call

You have two methods for making a call:

*  Short Dial. If the number is in the phone book of the EXPLORER™ 500, you can use the Short
Dial number, which is found in the first column of the phone book in the web interface. See
Short dial on page 83.

Simply dial 0 <Short Dial> followed by # or off-hook key.

Example: To call entry number &4 in the phone book,
dial 0& followed by # or off-hook key.

*  Manual Dial. To make a call, dial
00 <country code> <phone number> followed by # or off-hook key.

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an analog phone,
dial 00 &5 39558800 #

If there was an error establishing the connection, the web interface and the display of the
EXPLORER™ 500 show an error message. Refer to the Troubleshooting Guide on page 131

Receiving a call

To be able to receive a call, the phone must be connected to the relevant interface on the
EXPLORER™ 500.

By default, all devices connected to the Phone/Fax interface or the Bluetooth interface will ring
when one of the mobile subscriber numbers is called. Note, however, that this depends on the call
type settings. Refer to Selecting the incoming call type on page 52.

Information of missed calls is stored in the call log of the EXPLORER™ 500. You can view the call
log with the display menu system or the web interface. See Calls menu on page 38 or Viewing the
lists of calls on page 85.
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Making a call to the EXPLORER™ 500

To make a call to a phone connected to the EXPLORER™ 500, dial
+870 <Mobile subscriber number>

* +isthe prefix used in front of the country code for international calls. This is 00 when calling
from countries in Europe and from many other countries.

*  Mobile subscriber number. If the mobile subscriber numbers are available on the SIM card,
you can look them up using the display menu system or the web interface.
* Display menu system:
Enter the menu system and select PROPERTIES > MOBILE NUMBERS.
* web interface:
If a computer is connected, access the web interface, select PROPERTIES and locate the
Mobile subscriber numbers section. For further information on the web interface, see The
web interface on page 74.
If the mobile subscriber numbers are not available in the display menu system nor the web
interface, refer to your airtime subscription.

[E®» |There are two Voice numbers, one for 3.1 kHz Audio and one for Standard Voice.
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Dialing functions

Overview

There are a number of dialing functions available in the EXPLORER™ 500.

The following list shows the allocated special-purpose numbers for the EXPLORER™ 500.

Number

Function

0 * followed by # or off-hook key

Redial last called number on this interface.

00 * followed by # or off-hook key

Redial last answered call on this interface.

Note: If the last answered number is an unlisted
number, you will not be allowed to dial back.

0 followed by one of the numbers 1-199
and # or off-hook key

Short dial phone numbers in phone book.

0200 followed by # or off-hook key

Local call broadcast to all Bluetooth handsets.
All connected Bluetooth handsets will ring. The
first handset that answers, takes the call.

0 followed by one of the numbers 201-207
and #

Local call to Bluetooth handset.

0301 followed by # or off-hook key

Local call to analog phone.

0900 followed by # or off-hook key

Local call broadcast to all handsets.

Apart from the numbers above, the EXPLORER™ 500 uses the following dialing prefixes:

1* hefore the phone number will force the connection to use Standard Voice.

2* before the phone number will force the connection to use 3.1 kHz Audio.

#31# before the phone number will hide the callers phone number to the recipient.

*31# before the phone number will show the callers phone number to the recipient where it
would otherwise be hidden, e.g. because the number is an ex-directory number.

R is used during a call to indicate that the following key-presses should activate a
supplementary services function. The supplementary services functions supported by the
EXPLORER™ 500 are described in the subsequent sections.
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Making local phone calls

You can make local calls between phones connected to the EXPLORER™ 500.
Local phone numbers always start with 0.
For an overview of the numbers, see Overview on page 58.

To make a local call, dial
<local number> followed by # or off-hook key.

LB | You cannot make local calls between two Bluetooth handsets through the
EXPLORER™ 500. You can only make local calls between an analog phone and a
Bluetooth handset.

Up to 7 Bluetooth handsets can be connected at the same time, but only one call can be active on
the Bluetooth interface.

You can look up the local Bluetooth phone numbers in the display or in the web interface as
follows:
* Display
Enter the menu system and select PROPERTIES > BLUETOOTH DEVICES. The list
shows all accepted Bluetooth devices with local number and Bluetooth name.

¢ web interface
Access the web interface and select
SETTINGS > Interfaces > Bluetooth > Paired Devices.
The paired voice devices are listed with their local phone numbers.

Handling waiting calls

L | The phone must have an R key to be able to use these functions.
The EXPLORER™ Bluetooth Handset uses a softkey in stead of the R key.
During a call, if a second party attempts to make contact with you, you will hear a Call Waiting

indication. The Call Waiting indication is two beeps and a pause of 3 seconds, then two beeps
again etc. If no action is taken, the waiting call is released after a time out period.

When you receive a Call Waiting indication, you have the following options:

If you want to: Do as follows:

Clear the current call, Press R 1 #, within the time out period.
and accept the waiting call.

Hold the current call, PressR 2 #, within the time out period.
and accept the waiting call.

Ignore the waiting call. Take no action.

Reject the waiting call. PressR 0 #, within the time out period.
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Holding a call

LE» | The phone must have an R key to be able to use these functions.
The EXPLORER™ Bluetooth Handset uses a softkey in stead of the R key.

During a call, you may place the initial call on hold while another call is made.

If you want to: Do as follows:
Place a call on hold. PressR 2 #.
Place the existing call on hold and establish a | Press R and dial the second phone number
new call. followed by #.
Shuttle between the two calls. PressR 2 #

(irrespective of whether the second call was
acquired using Call Hold or acceptance of Call
Waiting.)

Clear the held call, if no waiting call exists. PressR 0 #.

Clear an active call and return to the held call. | PressR 1 #.
Note that this is only possible if no waiting
call exists.

Transferring a call

Ly | The phone must have an R key to be able to use these functions.
The EXPLORER™ Bluetooth Handset uses a softkey in stead of the R key.

When you receive a call, you can transfer this call to another phone or headset connected to the
EXPLORER™ 500.

To transfer the incoming call to another phone or headset, do as follows:

1. Press R & * <local number> #.
The phone or headset with the local number you dialed starts to ring.
If your phone and the recipient’s phone or headset are both Bluetooth devices, your phone is
now disconnected. When the call is answered, a connection is established between the initial
caller and the new recipient.

2. Ifonly one or none of the devices are Bluetooth devices, you have two options.

* Hang up. The phone or headset you transferred the call to continues to ring. When the call
is answered, a connection is established between the initial caller and the new recipient.

* Do not hang up. When the new recipient answers, you can have a conversation before
hanging up. When you hang up, the call is handed over to the initial caller.
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Sending or receiving a fax message

Handling delays

When sending or receiving fax messages over satellite, both fax units must be capable of handling
longer delays without timing out. Some fax machines have an Overseas mode, which enables the
unit to handle the long delays.

Sending a fax message

The fax machine must be connected to the Phone/Fax interface of the EXPLORER™ 500. Refer to
Before connecting to the Phone/Fax interface on page 53.

3.1 kHz Audio must be used for an analog fax machine. Refer to Selecting the default outgoing call
type on page 51.

To send a fax from a fax machine connected to the EXPLORER™ 500, dial
00 <country code> <phone number> #

Example: To send a fax to Thrane & Thrane in Denmark (+45 39558888),
dial 00 4539558888 #

[T |If the default setting in the web interface is not 3.1 kHz Audio, you can dial 2 * before the
number, to force the connection to use 3.1 kHz Audio. For further information, see
Selecting the default outgoing call type on page 51

Receiving a fax message
An analogue fax machine connected to the EXPLORER™ 500 can only receive a fax with 3.1 kHz
Audio. Refer to Selecting the incoming call type on page 52.

Make sure the fax is sent to the 3.1 kHz Audio phone number and that 3.1 kHz Audio is enabled for
the Phone/Fax interface.
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Using a computer

Choosing an interface for data connection

The EXPLORER™ 500 has three types of interface for data connection: LAN, USB and Bluetooth.

The following table shows some characteristics of each interface, to help you choose the right
interface for your application.

Power
Interface oo Amount of Setup Range
LAN High None Up to 100 m of cable
(or very little)
UsSB Low Some setup necessary | Upto 5 m of cable
Bluetooth | Medium Can be complicated, Wireless connection.
depending on Up to 100 m depending on the
operating system. transmitter in the computer and on
the transmission conditions.
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Standard or Streaming data

Definition
The BGAN network supports different classes of data connection to the Internet. The main classes
are Standard data and Streaming data.

* Using a Standard data connection, several users can share the data connection
simultaneously. This type of connection is ideal for TCP/IP traffic such as e-mail, file transfer,
and Internet and intranet access.

The user pays for the amount of data sent and received.

» Using a Streaming data connection, you get an exclusive, high-priority connection, ensuring
seamless transfer of data. This type of connection is ideal for time critical applications like live
video over IP.

The user pays for the duration of the connection (per minute charge).

LBy | For optimum performance it is important that you select the right traffic class when
defining Profiles for your connection.

You can set up various types of connection using the Profiles and a Traffic Flow Template. For

further information, see Using Profiles on page 118 and Using a Traffic Flow Template on page 121.

Setting up and activating a Streaming connection

By default, any data connection on the EXPLORER™ 500 is a Standard data connection.

If you want to set up a Streaming connection, select a Streaming Profile when setting up your data
interface. See the “Configuring...” section for your interface in Chapter 5, Using the web interface.

Before starting a Streaming session on the LAN interface, make sure you have set up the
Streaming Profile for the LAN interface.

To start or stop a Streaming session on the LAN interface, do as follows:

1. Access the web interface.

2. Go to the Home window and locate the field STREAMING PROFILES ON LAN.
3. Click the Start or Stop link of the relevant Streaming Profile.

[E®» |When running a Streaming session you are charged for the time you are connected.
A started Streaming session will stay active until you stop it.
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Using the LAN interface

Before connecting to the LAN interface

To connect to the LAN (Local Area Network) interface, use a shielded cable mounted with an R]-45
connector.

The LAN interface is configured as MDI-X. This means that if you are connecting your computer
directly to the EXPLORER™ 500, you should use a straight cable. If you are connecting a switch to
the EXPLORER™ 500, use a crossed cable.

For specifications, refer to LAN interface on page 145.

For the LAN interface to work without any further setup, the computer must be set up to obtain an
IP address and a DNS server address automatically.

To check these settings on your computer, do as follows (For Windows XP):
1. Select Connect To > Show All Connections from the Start menu.

2. Double-click Local Area Connection.

3. Click Properties

4. Select Internet Protocol (TCP/IP) from the list and click Properties.
Make sure both fields are set to obtain an address automatically.

Internet Protocol (TCP/IP) Properties ed |

General | Altemate Configuration I

“'ou can get [P zettings azsigned automatically if pour nebwork, supparts
thiz capability. Othenwize, pou need to azk vour network. adrministrator for
the appropriate P settings.

' ‘Obtain an |P address automatically

— Lze the following IP address:
|F address: I

Subnet mask: I

Lrefault gatewan I

' Obtain DMS server address automatically

— Lze the following DMS server addreszes;

Ereferred S zemen I

Alternate NS server I

Advanced... |
k. I Cancel |
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Connecting to the LAN interface

This section does not describe configuration of the LAN interface. For information on
configuration, see Configuring the LAN interface on page 101.

To connect to the LAN interface, do as follows:

L

4.

Connect the LAN cable to the network interface of your computer.
A suitable cable is provided with your EXPLORER™ 500.

Connect the other end of the cable to the LAN
connector on the EXPLORER™ 500. ' -m’

Power up the EXPLORER™ 500 and point the antenna as described in Pointing the antenna on
page 21.

After pointing, the connection is automatically established. By default, the connection is a
Standard data connection.

Check the connection, e.g. by starting your Internet Browser.

If connection fails, check that the interface is enabled in the EXPLORER™ 500. If the LAN icon is
not present in the display Main screen and in the Home window of the web interface, the interface
is disabled. See Enabling or disabling an interface on page 49.

If connection still fails, refer to the Troubleshooting Guide on page 132.
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Using the USB interface

Before connecting to the USB interface

To connect to the USB (Universal Serial Bus) interface, use a USB cable mounted with a USB Mini-
B connector. A suitable cable is provided with your EXPLORER™ 500. For specifications, refer to
USB interface on page 146.

First time setup of USB

If it is the first time you connect your computer to the EXPLORER™ 500 using the USB interface, or
you have exchanged the EXPLORER™ 500 with another EXPLORER™ 500, you must install a driver
as follows:

L

2.

10.

1L

12.

13.

Power up your computer.

Connect the USB cable to the USB port of your computer.

Connect the other end of the cable to the USB N

connector on the EXPLORER™ 500.
Power up the EXPLORER™ 500 as described in Getting started on page 11.

Your computer should now automatically discover that new hardware is connected.

[T | The following description is for Windows XP. If you are using a different operating
system, the procedure may be different.

On Windows XP, the New Hardware Wizard will start automatically. Go through the wizard as
follows:

In the New Hardware Wizard, select No, not this time when you are asked if Windows can
search for software.

Click Next.

Insert the Thrane & Thrane CD-ROM provided with your EXPLORER™ 500 into the CD-ROM
drive of your computer.

Select Install the software automatically and click Next.

If you get a warning that the software has not passed Windows logo testing, you can safely
click Continue Anyway.

Click Finish when the installation is complete.
When you finish the wizard, the Thrane & Thrane EXPLORER™ USB driver is installed.

Create a dial-up connection as described in Creating a dial-up connection on page 70.
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Connecting to the USB interface

This section does not describe configuration of the USB interface. For information on
configuration, see Configuring the USB interface on page 99.

If you are connecting your computer to the USB interface for the first time, see First time setup of
USB on page 66.

To connect to the USB interface, do as follows:

L

2.

Power up your computer.
Connect the USB cable to the USB port of your computer.

Connect the other end of the cable to the USB N
connector on the EXPLORER™ 500.

Power up the EXPLORER™ 500 and point the antenna as described in Getting started on
page 11.

To enable communication on the USB interface, open your dial-up connection as described in
the following steps.

[E® | The following description is for Windows XP. If you are using a different operating
system, the procedure may be different.

In Windows XP, select Connect To from the Start menu.
Select the dial-up connection created for this USB connection.

Click Dial and wait for the connection to be established. Then start your Internet browser or
mail program.

If connection fails, refer to the Troubleshooting Guide on page 133.
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Using 64 kbps UDI (ISDN) through the USB interface

You can communicate using ISDN through the USB interface of the EXPLORER™ 500, provided that
your Internet Service Provider (ISP) supports Unrestricted Digital Information (UDI) and that it is
included in your subscription.

The necessary setup is very limited, so you can very quickly establish a live connection. Note
however, that you are charged for the time you are connected (per minute rate).

Do as follows:

L

2.

Make sure 64 kbps UDI is included in your subscription.

From your Airtime Provider, acquire the ISP phone number, User name and Password to
access the 64 kbps UDI service.

If you have not yet installed the Thrane & Thrane EXPLORER™ USB driver from the Thrane &
Thrane CD, install it as described in First time setup of USB on page 66.

Connect and create a dial-up connection as described in Creating a dial-up connection on
page 70, with the following exceptions:

* When you are asked for a phone number, type in the ISP phone number.

* When you are asked for User name and password, type in the User name and Password
provided by your ISP.

To enable communication, simply open your 64 kbps UDI dial-up connection and click Dial.
You now have a 64 kbps UDI connection to the Internet.
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Using a computer with Bluetooth

Before connecting a computer to the Bluetooth interface

The EXPLORER™ 500 supports various Bluetooth profiles. Remember to activate/install the
profile(s) you are going to use on your computer.

For a list of supported Bluetooth profiles, see Bluetooth interface on page 147.

The computer should be placed within a maximum distance of 100 m from the EXPLORER™ 500.
Note that this is the maximum distance in open air; the actual maximum distance may be shorter,
depending on the environment. In an office environment, you should be able to establish a
connection across the adjoining 2-3 rooms.

LT | The procedure may vary depending on the Bluetooth interface in your computer. Consult
your Bluetooth manual for details.

If the two devices have not been connected before, you need to pair the devices. For further
information, see the section Bluetooth pairing on page 50.

Connecting a computer to the Bluetooth interface
This section does not describe configuration of the Bluetooth interface. For information on
configuration, see Configuring the Bluetooth interface on page 104.

If the devices are already paired, do as follows to connect:
1. Place the computer close to the EXPLORER™ 500.

2. Power up the EXPLORER™ 500 and point the antenna.
3. Power up your computer.

4. Turn on Bluetooth on your computer.
If the devices are paired, the Bluetooth connection should now be established.
Note that if your Bluetooth connection is defined as a dial-up connection, you have to open
the dial-up connection before you can access the Internet or the web interface. See
Connecting to the USB interface on page 67.

LB | Max. 7 devices can be connected simultaneously.

If connection fails, check that the interface is enabled in the EXPLORER™ 500.

If the Bluetooth icon is not present in the display Main screen and in the Home window of the web
interface, the interface is disabled. See Enabling or disabling an interface on page 49. If the
interface is enabled but connection fails, refer to the Troubleshooting Guide on page 134.
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Creating a dial-up connection

Do as follows:

LT | The following description is for Windows XP. If you are using a different operating

10.

system, the procedure may be different.
Start up your computer and the EXPLORER™ 500.
Connect the USB cable between your computer and the USB connector on your
EXPLORER™ 500, or place your paired Bluetooth computer close to the EXPLORER™ 500. For
information on Bluetooth, see Using a computer with Bluetooth on page 69.
On your computer, select Connect To from the Start menu.
Select Show All Connections.
Open the New Connection Wizard and click Next.
Select Connect to the Internet and click Next.
Select Set up my connection manually and click Next.
Select Connect using a dial-up modem and click Next.
If other modems are installed, you must select the Thrane & Thrane EXPLORER™ USB driver,
or the Bluetooth driver, from a list of modems.
In the ISP Name field, type a name for your connection and click Next.
When you are asked for a phone number, type:

*98# if you want a Standard data connection to the Internet and/or the web interface, or *99#
if you are going to connect only to the web interface of the EXPLORER™ 500.

Mew Connection Wizard
Phone Humber to Dial
Y'hat iz your [SP's phone number?

Type the phone number below.

Phone number:

I"ElEltﬂ

'ou might need to include a *1" or the area code, or bath. [f o are nat sure
wou need the extra numbers, dial the phone number on pour telephone. [ pou
hear a modem gound, the number dialed iz comect,

< Back I Mesit » I Cancel
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To dial up using a specific Profile, type *98*<CID>#.

To find the <CID> number, access the web interface, select SETTINGS > Interfaces > USB (or
Bluetooth) and locate the Profile CIDs section at the bottom of the window.

For further information, see Configuring the USB interface on page 99 or

Configuring the Bluetooth interface on page 104.

11.  Click Next.

12. If you are using UDI, enter the User name and Password and click Next.
If you are not using UDI, simply click Next without entering User name and Password.
See Using 64 kbps UDI (ISDN) through the USB interface on page 68.

13. Click Finish.

When you connect to the USB interface, or to the Bluetooth interface using dial-up, you must open
this dial-up connection to access the Internet or the web interface.

To open the dial-up connection (in Windows XP), select Connect To from the Start menu, select
your dial-up connection and click Dial. When the connection is established, you can access the
Internet as usual.

LE®» | You may need to enter User name and Password to access the Internet. If necessary,
enter the User name and Password supplied by your Internet Provider.
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Additional interfaces

Using an external antenna

You can connect an external antenna to the EXPLORER™ 500.

Only use the specified antenna from Thrane & Thrane. The antenna is listed in
Options and accessories on page 127.

The connector for the external antenna is located at the
back of the EXPLORER™ 500 and is marked ANT.

For information on cable and connector type, refer to the
specifications in External antenna on page 149.

Using the EXPLORER™ Bluetooth Handset charger

Before connecting to the EXPLORER™ Bluetooth Handset charger interface

If you are using an EXPLORER™ Bluetooth Handset, you can recharge the handset using the DC
charger interface of the EXPLORER™ 500.

Use the charger cable supplied with the EXPLORER™ Bluetooth Handset.

For specifications on the charger interface, see EXPLORER™ Bluetooth Handset charger interface
on page 150.

Connecting to the EXPLORER™ Bluetooth Handset charger interface
Do as follows:

1. Connect the EXPLORER™ 500 to power, either using the AC/DC adapter connected to a 100-
240 V AC electrical outlet, or the Car charger cable connected to the cigarette lighter
socket/12 V DCin a car.

[T | The Bluetooth handset charger cannot recharge the Bluetooth handset from the
EXPLORER™ 500 battery. The EXPLORER™ 500 must be connected to external
power.

2. Connect the Bluetooth charger cable to the charging
connector on the EXPLORER™ 500.
The charging connector is located at the back of the
EXPLORER™ 500, and is marked DC OUT. Make sure
the connector is oriented correctly in relation to the
coding of the plastic insert.

3. Connect the other end of the cable to your EXPLORER™ Bluetooth Handset.
If the EXPLORER™ 500 is connected to power, the battery of the Bluetooth Handset is now
recharged.
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What's next?

This chapter has described the basics of how to set up and use each interface.

The following chapter, Using the web interface, describes how to use the built-in web interface for
setting up and using the EXPLORER™ 500.
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Using the web interface

In this chapter
This chapter describes how to use the web interface to operate, set up and configure the
EXPLORER™ 500.

Initial configuration of interfaces is described in the chapter Using the interfaces on page 47.

Introduction

The web interface

What is the web interface?
The web interface is a built-in web server in the EXPLORER™ 500, used for operating, setting up
and configuring the EXPLORER™ 500.
You can access the web interface from a standard Internet browser.

Internet Explorer 6.0, Mozilla Firefox 1.0 and Apple Safari 2.0 have been tested successfully with
the web interface.

You may be able to use other browser versions as well.

Connecting

Connect your computer to the EXPLORER™ 500.

Make sure your computer is set up for the interface you are planning to use for connecting to the
EXPLORER™ 500. You can use LAN, USB, or Bluetooth. See Using the interfaces on page 47 for
details.

To access the web interface, an Internet browser must be installed on the computer.

If you are going to use USB or Bluetooth with Dial-up Networking to access only the
web interface and not the Internet, you must use a dial-up connection with the
phone number set to *99#. For further information, see Creating a dial-up
connection on page 70.
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Browser settings
If you are connecting your computer using the LAN interface, the Proxy server settings in your
browser must be disabled before accessing the web interface.

Most browsers support disabling of the Proxy server settings for one specific IP address, so you
can disable Proxy server settings for the web interface only, if you wish. Consult your browser help
for information.

To disable the use of a Proxy server completely, do as follows:

LE» | The following description is for Microsoft Internet Explorer. If you are using a different
browser, the procedure may be different.

1. In Microsoft Internet Explorer, select Tools > Internet Options > Connections > LAN Settings.

Local Area Network (LAN) Settings 7| x|

—Aukomnatic configuration

Automatic configuration may override manual setkings, To ensure the
use of manual settings, disable automatic configuration.

[ Auromatically detect settings

[ Use automatic configuration scripk

Address I

— Proxy server

r I1z2 a progy server For wour LAN (These settings will not apply t-:u
dial-up or Y¥PM connections),

fAddress; |1III 1.1.8 Pork: I fdvanced, |

¥ | Bypass prowy: server for local addresses

2K I Cancel |

2. Uncheck the box labeled Use a proxy server for your LAN.

3. Click OK.
When the proxy server settings are disabled, close your browser.

You may need to change this setting back on return to your Internet connection.

TT 98-122274-M Introduction 75



Chapter 5: Using the web interface

Accessing and navigating the web interface

Accessing the

web interface

To access the web interface from a connected computer, do as follows:

L

Connect your computer to the EXPLORER™ 500.
For further information, see Using a computer on page 62.

Start up the EXPLORER™ 500.
For further information, see Getting started on page 11.

Open your browser and enter the IP address of the EXPLORER™ 500.

The standard IP address is 192.168.0.1.

If your EXPLORER™ 500 uses a different IP address, you can look it up by entering the display
menu system of the EXPLORER™ 500 and selecting

PROPERTIES > IP ADDRESS.

Overview of the web interface

The

Status R B
Field \pw
Navigation

Pane —p

web interface consists of the following sections.

Icon Bar Menu Path Contents Section

Thrane & Thrane
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*  The navigation pane holds the main menu. Clicking an item in the menu opens a submenu in
the navigation pane or a new page in the contents section.

*  The status field shows battery status and signal strength.

¢ Theicon bar shows an icon for each interface that is enabled. It also shows icons for new SMS
messages and for active alarms, when relevant. For explanations of the icons, see the next
section, Icons in the icon bar.

*  The menu path shows the path through the menu system to the current page shown in the
contents section.

*  The contents section shows the page selected in the navigation pane. This section is used for
viewing or changing settings, or for performing actions.

Icons in the icon bar

The following icons may appear in the icon bar in the web interface:

Icon Explanation
Phone/Fax interface is on.
BT Bluetooth interface is on.

LAN interface is on.

e
os USB interface is on.
DA

A new SMS message, or information of Voice mail, has arrived.

Click the icon to see new messages or information of Voice mail. For
further information, see Receiving a message on page 89.

An alarm is pending.

>

Click the icon to see a list of active alarms. For explanations of the alarm
messages, see List of alarms on page 136.

Note that the alarm icon will remain in the icon bar as long as the cause
of the alarm is still present.

Navigating the web interface

* To expand a menu, click the menu in the navigation pane.

*  To access status and settings, click the relevant subject in the navigation pane, or anicon in
the icon bar. The status or settings are displayed in the contents section.

* To see the site map, click SITE MAP in the navigation pane. Click on items in the site map to
go directly to the relevant location.

*  To return to the Home window from anywhere in the system, click Home, either from the
navigation pane or from the menu path below the icon bar.
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Entering the SIM PIN in the web interface

If a computer is connected when you start up the EXPLORER™ 500, and the web interface is
accessed, you can enter the SIM PIN from the web interface.

Until you enter the PIN in the Home window, you can only access the PROPERTIES window and
upload software. Access to all other parts of the web interface requires a PIN.

»

Thrane & Thrane Gl Mt

BATIERY: [

s 0000000 [

Plzaze enter PIN

HOME PIN: I ﬂl
PROPERTIES
=
|&] Done I_I_I_I_I_lﬂ Internet 4

Type in the PIN and press OK.

If you enter a wrong PIN 3 times you are asked for a PUK (PIN Unblocking Key). For further
information, see Wrong PIN on page 20.

If the PIN has already been accepted in the EXPLORER™ 500, or the PIN is disabled e.g. from the
BGAN LaunchPad, the web interface goes directly to the Home window at start-up.

When the PIN is accepted, the web interface opens the Home window and is ready for use.
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The Home window

Overview

The Home window of the web interface contains a “dashboard” for control and inspection of
ongoing communication and for viewing properties of the EXPLORER™ 500.

The NETWORK section shows the name of the Airtime Provider, if this information is available on
the SIM card.

oy @]

STGNAL: EREERER

HOME

PHOKME BOOK

MESSAGES

CALLS

SETTINGS

PROPERTIES

ADMINISTRATION

HELPDESK

SITE MAP

Terminal properties

NETWORK

Airtirne provider Thrane 2 Thrane
TERMINAL

Status Crata active

Pointing Go to pointing rode
Unit serial number 05739323

Software version 1.04, build 1_50_01-3
Local IP address 19z.468.0.1

IMEI nurnber 35315000-0000232-8
MAC addrass 00:11:CFi00:39: AR

ONGOING DATA SESSIONS
Strearming 128 kbps (10.10,10.54)
Standard data (10.10,10.54)
STREAMING PROFILES ON LAN

Stop User defined 4

The TERMINAL section of the Home window shows the following:

Status. The status of the EXPLORER™ 500. This field corresponds largely, but not completely,
to the status information in the display.
Examples of status information are: Ready, Registering and Data active.

SESSIONS TOTAL

Standard waoice inbound  O0:00:00
Standard woice outbound 00:00:45
21 kHz audic inbound  00:00:00

3.1 kHz audio outbound 00:00:00

Standard data 9.97 MB

Strearing 32 kbps Q00000
Strearning 64 kbps 00:00:00
Strearning 128 kbps 00:06:50

ONGOING CALLS

Standard woice 00:00:45

Pointing. If you want to point the antenna, click the link Go to pointing mode. For further
information, see Pointing using web interface on page 81.

Unit serial number. The serial number of the total unit.
Software version. The version of the software embedded in the EXPLORER™ 500.
Local IP address. The local IP address of the EXPLORER™ 500.

IMEI number. The IMEI number (International Mobile Equipment Identity) of the
EXPLORER™ 500. This is a unique number that identifies your EXPLORER™ 500.

MAC address of the EXPLORER™ 500.
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Managing calls and data sessions

Start/stop a Streaming session on the LAN interface

LBy | Before starting a Streaming session, make sure you have set up a Streaming Profile and
activated it in the SETTINGS > Interfaces > LAN window.

To start or stop a Streaming session, click the relevant link under STREAMING PROFILES ON LAN.
For information on setup of the LAN interface, see Configuring the LAN interface on page 101. For
information on how to set up a Profile, see Using Profiles on page 118.

Viewing information on calls and data sessions

The following sections in the Home window show information on calls and data sessions.

*  ONGOING CALLS is a list of calls that are currently active. The list shows the Voice quality and
the time connected for each call.

*  ONGOING DATA SESSIONS is a list of data Profiles that are currently active, including the IP
address that is assigned to each PDP context.

e SESSIONS TOTAL lists the totals for each connection. The list shows the time connected for
voice and Streaming data, and MB transferred for Standard data.
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Pointing using web interface
Instead of using the display for observing the signal strength you can view and accept the signal
strength in the web interface.
Do as follows:

1. From the TERMINAL section of the Home window in the web interface, click the link Go to
pointing mode. The Pointing window opens, and the EXPLORER™ 500 enters pointing mode.

pointing the antenna. The frequency of the sound increases with the signal strength.

To toggle the pointing sound on/off, press A or ¥on the keypad of the

t this point the may make a sound. This sound 1s used for
At this point the EXPLORER™ 500 k d. Thi di d f
EXPLORER™ 500.

2. Point the antenna as described in Pointing the antenna on page 21, while observing the signal
strength in the web interface.
3. When you have obtained the highest signal strength you can get, click Accept.

The web interface now returns to the Home window, and the EXPLORER™ 500 tries to establish a
connection and register on the BGAN network.
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Using the phone book

General usage

Overview

In the phone book you can:
*  Look up phone numbers.
*  Look up short dial numbers for easy dialing from an analog or Bluetooth handset.

*  Modify or delete existing names and phone numbers, or enter new names and phone
numbers.

Accessing the phone book

To access the phone book, select PHONE BOOK from the left navigation pane.

sieva: —— IEEROO0

HOME

PHONE BOOK

| [(saveenty ]
s 2uatentia)

MESSAGES

CALLS

SETTINGS

PROPERTIES

ADMIMISTRATION

HELPDESK

SITE MAP

The phone book shows all entries with entry number, name and phone number. Empty place
holders are also included.

To sort the phone book, click the title of the column you wish to sort by. For example, to sort by the
names in the phone book alphabetically, click on Name in the top row of the phone book.

The phone book is divided into subpages. To select the subpages you want, click the relevant link
at the bottom of the page.
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Short dial

The entry number in the phone book is the Short dial number. When making a call from the
EXPLORER™ 500 you can use this number instead of dialing the entire phone number.

Simply dial 0 <short dial> followed by # or off-hook key.

Example: To call the third entry in the phone book from an analog phone, take the phone off hook
and dial 03 #.

Editing phone book entries

Adding a new entry
To add a new entry, do as follows:

1. In the phone book, locate the empty entry number where you want to add the new phone
number and click New.

2. Typein the name and phone number of the new entry and click Save entry.
The new name and number are now listed at the specified entry number in the phone book.

Modifying an entry in the phone book
To modify an entry, do as follows:
1. Inthe phone book, click Edit next to the entry you want to modify.

2. Modify the name or number as wanted and click Save entry.
The name and/or number in the selected entry is now replaced with the new information.

Deleting an entry in the phone book

To delete an entry, click Delete next to the entry you want to delete.

Deleting all entries in the phone book

To delete all the entries in the phone book, click Delete all entries in phone book at the bottom of
the PHONE BOOK window.
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Call log

Information on total usage

To enter the CALLS window select CALLS from the left navigation pane. The CALLS window
contains information on usage for circuit switched connections. The listed information includes:

*  Time connected using Standard Voice and

* time connected using 3.1 kHz Audio.

Thrane & Thrane bgon] inenarsat’

SIGNAL: 0000000

TOTAL USAGE

HOME
Standard vwoice: 0.0 Minutes

PHONE BODK

MESSAGES 3.1 kHz Audio: 0.0 Minutes

CALLS

Dutgeing calls Export total Call Log to file

Recesived calls
Mizzed calls
Standard data sessions

Strearning data sessions

i€l l_l_’_’_|_|ﬂ Inkernet

N | K

Exporting the call log

The EXPLORER™ 500 logs all calls and data sessions. For information on how to view the lists of
calls and data sessions, see the next section.

To export the entire call log to a file, do as follows:
1. Inthe CALLS window, click the link Export total Call Log to file.
2. Browse to the location where you want to save the log.

3. Click OK.
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Viewing the lists of calls
To see information on outgoing, received or missed calls or data sessions, select one of the
following lists from the left navigation pane in the CALLS window:

*  Outgoing calls shows the start time, receiving end phone number, duration, type (Standard or
3.1 kHz Audio) and estimated charge of each outgoing call.

*  Received calls shows the start time, calling phone number, duration and type (Standard or
3.1 kHz Audio) of each incoming call.

*  Missed calls shows the start time, calling phone number and type (Standard or 3.1 kHz Audio)
of each incoming call that was not received.

» Standard data sessions shows the start time, bytes in, bytes out and estimated charge of each
Standard data session.

»  Streaming data sessions shows the start time, duration, type (Streaming 32, 64 128 kbps) and
estimated charge of each Streaming data session.

Date and time is UTC time, received from the satellite.

[T | The estimated charge is based on your entries under ADMINISTRATION > Call charges.
Thrane & Thrane does not take responsibility for the correctness of this estimated
charge.

You can sort each of the lists by clicking the title of the column you wish to sort by.

If a list covers more than one page, you can click the relevant link at the bottom of the page, to go
to another page.

When there are more than 100 calls in the total list, the oldest calls are automatically removed to
make room for new calls.
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Handling messages

Sending an SMS message from the EXPLORER™ 500

If the EXPLORER™ 500 is not online when you attempt to send a message, the
message is moved to the Outbox in stead of the Sent folder. Messages in the
Outbox are not automatically sent when the EXPLORER™ 500 goes online. For
further information on the Qutbox, see the next section, Options for messages in
the Outbox.

To make sure a message has been sent, check that it has been moved to the
Sent folder.

To send an SMS message from the EXPLORER™ 500, do as follows:

1. Click MESSAGES from the left navigation pane.
This window contains new incoming messages.

2. Inthe left navigation pane, click Write message.

Thrane & Thrane bgon] inmarsat.

BATTERY: [
SIGNAL: goooooo

WRITE NEW MESSAGE:

HOME :I p—
PHOME BOOK

MESSAGES

Inbox ;I

Write message
9 Please note that text cver 160 characters will be sent as rultiple messages.

Cutbax
sy Thiz vill be sent as Il messagels)

Massageisettings Delivery naotification: Cives g

CALLS

Pr— Recipiant: | SE_ndI

PROPERTIES

ADMINISTRATION

HELPDESK

SITEMAP 5
@ T [ [ e ”

3. Typein the message in the Write new message field.
If the message text is too long for one SMS, the message is sent as two or more SMS
messages. The field below the message field shows the number of SMS messages used to
send the message.
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4. Typein the phone number in the Recipient field.
Remember 00 and country code
(e.g. 00 45 to call Denmark or 00 1 to call USA).

5. Select whether or not you want Delivery notification for this SMS message.
If you click Yes, the Status column in the Sent folder will show the status of your message
when it has been sent.
You can set up delivery notification generally for all SMS messages. This setting is used by
default when you send a message. For further information, see Configuring message settings
on page 91

6. Click Send.
The message is now sent and moved to the Sent folder.
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Options for messages in the Outbox

Messages in the Qutbox are messages that have not been sent, e.g. because the EXPLORER™ 500
was not online when you attempted to send the messages.

To access the Outhox, click MESSAGES > Qutbhox from the navigation pane.

You have the following options for messages in the Outhox:

When the EXPLORER™ 500 is online, click Resend next to the message you want to send.
When the Write message window opens, click Send.

The EXPLORER™ 500 now attempts to send the message again. To make sure the message
has been sent, look in the Sent folder.

LB |The original message remains in the Outbox. When you have succeeded in sending
the message you may want to delete it from the Outbox.

Click Delete next to a message to delete it.

Click Delete all messages in Outhox to delete all the messages.

Options for messages in the Sent folder

The Sent folder contains SMS messages that have been sent.

To access the Sent folder, select MESSAGES > Sent from the navigation pane.

The Status column shows the status of each message, if you have selected Delivery notification
when sending the message.

From the Sent folder you have the following options:

Click Resend next to a message you want to send again.
When the Write message window opens, click Send.

The EXPLORER™ 500 now attempts to send the message again. To make sure the message
has been sent, look in the Sent folder. There should now be two copies of the sent message.

Click Forward next to a message you want to forward.

When the Write message window opens, type in the phone number of the new recipient and
click Send.

The EXPLORER™ 500 now attempts to send the message to the new recipient. To make sure
the message has been sent, look in the Sent folder.

Click Delete next to a message to delete it.

Click Delete all sent messages to delete all the messages.
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Sending an SMS message to the EXPLORER™ 500

You can send an SMS message to the EXPLORER™ 500 e.g. from a mobile phone, using one of the
mobile subscriber numbers for voice. Dial

+870 <Mobile subscriber number>

To see the voice numbers of your EXPLORER™ 500, select PROPERTIES from the web interface or
from the display menu system and view Mobile subscriber numbers. Note, however, that these
numbers are only listed if they are available on the SIM card. Otherwise, refer to the information
included with your airtime subscription.

[T | There are two Voice numbers, one for 3.1 kHz Audio and one for Standard Voice.

Receiving a message

If a message has arrived, the icon bar at the top of the web interface shows an unopened
envelope. Click the envelope to see the new message(s).

Otherwise, to see new messages, click MESSAGES from the left navigation pane.

The window shows new incoming messages.

L%y | The EXPLORER™ 500 does not accept more than 100 incoming messages (including read
and unread messages). If you have received 100 messages, you have to delete some of
them in order to free space for new messages. Otherwise, the new messages are
rejected.

If the message is not an SMS message but information of voice mail, call your voice mail service
number to hear the voice mail.

To find your voice mail service number, select MESSAGES > Message settings from the left
navigation pane and locate the Voice mail service number.

Note that the voice mail number is only shown if it is available on the SIM card. Otherwise, refer to
the information included with your Airtime subscription.
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Options for new SMS messages

To see new messages, click MESSAGES from the left navigation pane.

Besides viewing the new messages, you have a number of options for what to do with each
message:

Click Read to move it to your Inbox containing read messages.

Click Reply to reply to a message.

Then type in your reply and click Send.

For information on how to include the original message in your reply, see Setting up the
default message options on page 91.

Click Forward to forward a message to someone.
Then type in the phone number in the Recipient field and click Send.

If you want to move all the new messages, click Move all new messages to Inbox.

LT | New messages cannot be deleted until they have been moved to the Inbox.

Options for SMS messages in the Inbox

The messages in the Inbox are the incoming messages that have been read and moved from the
list of new messages (refer to the previous section).

From the Inbox, you have the following options:

Click Reply to reply to a message.

Then type in your reply and click Send.

For information on how to include the original message in your reply, see Setting up the
default message options on page 91.

Click Forward to forward a message to someone.
Then type in the phone number in the Recipient field and click Send.

Click Delete to delete the message.

Click Delete all messages in Inbox to delete all read messages in the Inbox.
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Configuring message settings

Setting up the default message options

You can set up general options for your outgoing messages. These settings apply by default to all
your outgoing messages. Note, however, that you can change the Delivery notification setting for
an individual message. For further information, see Sending an SMS message from the
EXPLORER™ 500 on page 86.

Do as follows:

1. Select MESSAGES > Message settings from the left navigation pane.

Thrane & Thrane bgan] ismarsat

BATIERY: 14
SIGNAL: oooooaon

SMSE zervice centre: +387077200179% Edit

Waice mail number:

HOME
PHONE BOOK Include meszage in reply: i Yas g Ma
MESSAGES Delivery notification: Cves % N
Inbox

Apply | _Cancel |

Write message
Cuthox
Sent

Mezzage settings

2. If you want to include the original message when you reply, select Yes next to Include
message in reply.

3. Select whether or not you want Delivery notification for SMS messages.

If you click Yes, the Status column in the Sent folder will show the status of your message
when it has been sent.

4, Click Apply.
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Viewing or changing SMS service center number
The SMS service center number identifies the SMS service center used when sending and
receiving SMS messages. The SMS service center number is stored on the SIM card.

* To see the SMS service center number, select
MESSAGES > Message settings from the left navigation pane.

*  To change the number, click Edit next to SMS service center, change the number and click
Save. Then click Apply to apply all changes in the window.

The SMS service center number is provided from your Airtime Provider.

Viewing the Voice mail number

The Voice mail number is the number you call to hear your incoming voice mails.

L | The Voice mail number is only listed if it is available on the SIM card. Otherwise, refer to
the information included with your Airtime subscription.

To see the Voice mail number, select
MESSAGES > Message settings from the left navigation pane.
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EXPLORER™ 500 settings

Accessing the EXPLORER™ 500 settings

Select SETTINGS from the left navigation pane. The SETTINGS window contains the local settings of
the EXPLORER™ 500. The next sections describe these settings.

Power up behavior

Pointing at power up

If the EXPLORER™ 500 is placed in a fixed position it may not be necessary to go through the
pointing process every time the EXPLORER™ 500 is powered. You can set up the EXPLORER™ 500
to automatically establish a connection to the BGAN network, if you know that the signal strength
is sufficient.

L

2.

In the Power up section of the SETTINGS window, select whether or not pointing is required at
power up.

* To go through the pointing process every time the EXPLORER™ 500 is powered, select Yes.

* To have the EXPLORER™ 500 automatically register itself on the network every time the
EXPLORER™ 500 is powered, select No.

Click Apply.

If you have selected that pointing is not required at power up, the start up procedure will be as

follows:
1. Power up.
2. Enter the PIN. After the PIN is accepted, the EXPLORER™ 500 immediately tries to connect to

and register on the BGAN network.

Automatic power up

L

In the Power up section of the SETTINGS window, select whether or not the EXPLORER™ 500
should switch on automatically when external power is applied.

* To have the EXPLORER™ 500 switch on automatically when external power is applied,
select Yes.

* To have the EXPLORER™ 500 switch on only when the power button is pressed, click No.

Click Apply.

TT 98-122274-M EXPLORER™ 500 settings 93



Chapter 5: Using the web interface

Setting the display backlight and contrast

To set the display backlight and contrast, do as follows:

L

In the Backlight section of the SETTINGS window, set the timing.
The Timed period is the period of time the light will stay on after the last key is pressed.

Set the level of the backlight with the Set level scroll bar.

In the Contrast section, click Yes next to Automatic if you want the contrast to be adjusted
automatically according to the temperature.

The contrast of the display changes with the temperature. The EXPLORER™ 500 can
automatically adjust the contrast to compensate for these variations.

If you want to set the contrast manually, set the contrast level with the Set level scroll bar.

Click Apply.

Turning audio indicators on or off

The EXPLORER™ 500 has audio indicators for different events or situations.

To enable or disable these audio indicators, do as follows:

L

2.

In the Audio indicators section of the SETTINGS window, turn the audio indicators on or off
using the radio buttons. Each audio indicator is explained below.

Click Apply.

The EXPLORER™ 500 has audio indicators for the following events:

Pointing.

The Pointing sound is used during the pointing process. The frequency increases with the
signal strength, to help you find the maximum signal strength when pointing the antenna.
This setting is a default setting. When the EXPLORER™ 500 is in pointing mode, you can
toggle pointing sound on/off for the current pointing process using A or ¥on the keypad of
the EXPLORER™ 500. However, the default setting applies at the next pointing process.

Messages.
The Message indicator is a sound indicating that a message has arrived.

Alarm.
The Alarm indicator is a sound indicating that an alarm is issued.
An alarm is issued if the EXPLORER™ 500 detects an error that requires your action.
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Enabling activation of stealth mode

In Stealth mode, the EXPLORER™ 500 operates with no sounds nor lights. However, it is still
possible to operate the EXPLORER™ 500 and the display text is, in most cases, readable.

[LTELEND | Only enable activation of Stealth mode if you are going to use it. If Stealth mode is
activated by mistake, it may be difficult to operate the EXPLORER™ 500.

To enable the use of Stealth mode for the EXPLORER™ 500, do as follows:
1. Select SETTINGS from the left navigation pane.

2. In the Stealth mode section, click Enable.
If you click Disable, the Stealth mode function cannot be activated.

3. Click Apply.

[T | This setting does not activate Stealth mode, it only enables the use of Stealth mode.
To activate Stealth mode, press C+OK on the keypad.

To deactivate Stealth mode and return to normal function, press C+OK again.
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Setting up the interfaces

Enabling/di

sabling interfaces

By default, all interfaces are enabled. However, you can disable the LAN interface, the Bluetooth
interface and/or the Phone/Fax interface in order to minimize power consumption.

Theicons in the Icon bar at the top of the web interface shows interfaces that are enabled. Clicking
an icon brings you to the window where you can set up the interface or enable/disable it.

L% |The USB interface cannot be disabled; it is always enabled.

1. Select SETTINGS > Interfaces from the left navigation pane.
»
Thrane & Thrane bgan| inmarsat
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INTERFACE STATUS
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HOME
LaM interface ¢ Enabled ™ Disabled |
PHOME BOOK
MESSAGES Eluetooth interface ™ Enabled | Dizabled
CALLS FhonefFax interface ™ gnabled { Disabled
SETTINGS Apply | Cancel |
INTERFACES
[NE=:)
LAam
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PROPERTIES
ADMINISTRATION
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SITEMAP ;I
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2. In the Interfaces window, select Enabled or Disabled next to the interface you want to
enable/disable.
3. Click Apply.
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Description of data settings

Introduction

There are several data parameters that can be set up in the web interface. This section gives an
overview of these parameters.

APN (Access Point Name)

The APN is used by the EXPLORER™ 500 user to establish the connection to the required
destination network. This means that the EXPLORER™ 500 must know the APN in order to be able
to connect to the destination network.

APNs are provided from the Airtime Provider. They may also be defined on the SIM card.

Header compression

The Header of a data packet contains control information belonging to that packet. The
information in the Header can take up a considerable amount of bandwidth. In order to save
bandwidth, you can use Header Compression, meaning you compress the header information,
leaving some of the information out.

You can select whether or not to use Header Compression for your data transmission.

*  Header Compression enabled: Recommended for low-noise applications.
If you select Header Compression enabled, you will be using less bandwidth on header
information, leaving more bandwidth for the actual payload.
However, if the environment is noisy, the system will have to retransmit information, and you
may end up using more bandwidth than without Header Compression.

*  Header Compression disabled: Recommended in noisy environments.
If Header Compression is disabled, the system will be less sensitive to noise.

Primary and secondary Profiles

A Profile is a collection of Quality of Service (QoS) settings and other settings defining the mode in
which data is transmitted on an interface. For example, a Profile is used to define whether a
connection should be a Standard or Streaming connection.

You can select between a number of predefined Profiles or define your own Profiles for your data
transmission.

LB |1f you have selected more than one Profile (one primary and one or more secondary
Profiles) for an interface, you must define a Traffic Flow Template before you can
establish a valid connection.

In the EXPLORER™ 500, you need an Administrator password to define Profiles and Traffic Flow
Templates.
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NAT (Network Address Translation)

NAT enables a local-area network to use one set of private IP addresses for internal traffic and an
assigned or static IP address for external traffic. The built-in NAT module in the EXPLORER™ 500
makes all necessary address translations between the local-area traffic and the external traffic.
If more than one user is connected to the LAN interface of the EXPLORER™ 500, it is necessary to
use a switch, as the EXPLORER™ 500 only has one LAN connector. If more than one user is
connected using a switch, you must select Router mode to use the NAT of the EXPLORER™ 500.
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Configuring the USB interface

LBy | The USB interface cannot be turned off; it is always on.

For an explanation of each of the data settings, see Description of data settings on page 97.

To configure the USB interface, do as follows:

1. Select SETTINGS > Interfaces > USB.

S iy
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Under TCP/IP, select whether your computer uses a Dynamic IP address or a Static IP address.

If you are using a static IP address, type in the address.

To check this setting on your computer, see the TCP/IP properties of the USB connection on

your computer.
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3. Select the source of the APN.
There are four options for setting the APN. Unless you have special requirements, it is
recommended to use the SIM default, or to set the common APN to SIM default, and then
select Common here. You have the following options:
* Common. The APN is taken from the Common settings defined under
SETTINGS > Interfaces > Common. Refer to Setting a common APN on page 110.

* SIM default. The APN is taken from the SIM card.
* Network assigned. The APN is assigned from the network.
* User defined. Type in the APN. APNs are provided from the Airtime Provider.

4. TIf your APN uses a password, type in the user name and password provided from the Airtime
Provider.

5. Select the Primary Profile.
Select a Profile from the scroll list. This Profile is used by the USB interface as a first choice,
when possible.

[LTEREND |1f you have selected a Streaming connection as your Primary Profile, the USB
interface will be running a Streaming connection until you select another
Profile or disconnect the interface. However, if you select one or more
Secondary Profiles, you can set up your Traffic Flow Template so that it will only
use the Streaming Profile for certain types of traffic.

There are 4 predefined Profiles: Standard, Streaming 32 kbps, Streaming 64 kbps and
Streaming 128 kbps. Additionally, you can define your own custom Profiles.

For further information on Profiles and Traffic Flow Templates, see Using Profiles on page 118
and Using a Traffic Flow Template on page 121.

6. Select the Secondary Profile.
To select more than one secondary Profile, press and hold Ctrl while selecting.

[ Note 2 If you have selected both a Primary and one or more Secondary Profiles you
must define a Traffic Flow Template before you can establish a valid
connection.

The Context Identifiers (CIDs) for the selected primary and secondary Profiles are listed under
Profile CIDs. You may need these CIDs when you create a dial-up connection. See Creating a
dial-up connection on page 70.

7. Click Apply.
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Configuring the LAN interface

For an explanation of each of the data settings, see Description of data settings on page 97.

CAUTION!

A\

To configure the LAN interface, do as follows:

1. Select SETTINGS > Interfaces > LAN.

If you are connected using LAN while changing the settings below, your
changes may affect your current connection.

i
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2. Select whether the LAN interface should be Enabled or Disabled.
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3. Under NAT, select whether the EXPLORER™ 500 should run in Router mode or in Modem
mode. Router mode is recommended for most purposes.
Select Router mode if one or more computers are connected using the LAN interface, and the
EXPLORER™ 500 should act as a router. When Router mode is selected, the EXPLORER™ 500
uses the built-in NAT module for making the necessary address translations.
Select Modem mode if
* only one computer is connected to the LAN interface, and the EXPLORER™ 500 should act

as a modem, or

* more than one computer is connected to the LAN interface using an external router.

LZ®» | Do not connect more than one computer to the LAN interface in Modem mode,
unless you have an external Router.

4. Under IP Header compression, select Enabled or Disabled. For information on this setting, see
Header compression on page 97.

5. Under DHCP status, enable or disable DHCP.
If you select Enabled, the internal DHCP server in the EXPLORER™ 500 is enabled.

6. Under Local IP address, type in the IP address and netmask for your EXPLORER™ 500.
This is the local IP address for your EXPLORER™ 500 when it is in Router mode.

7. Under TCP/IP, select whether your computer uses a Dynamic IP address or a Static IP address.
If you are using a static address, type in the address.
This is the IP address used externally on the satellite network.
To check this setting on your computer, see the TCP/IP properties of the LAN connection.

8. Select the source of the APN (Access Point Name).
There are four options for setting the APN. Unless you have special requirements, it is
recommended to use the SIM default, or to set the common APN to SIM default, and then
select Common here. You have the following options:

» Common. The APN is taken from the Common APN defined under
SETTINGS > Interfaces > Common. Refer to Setting a common APN on page 110.

* SIM default. The APN is taken from the SIM card.
* Network assigned. The APN is assigned from the network.
* User defined. Type in the APN. APNs are provided from the Airtime Provider.

9. If your APN uses a password, type in the user name and password provided from the Airtime
Provider.
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10. Select the Primary Profile.

B
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Select a Profile from the Primary scroll list. This Profile is used by the LAN interface as a first
choice, when possible.

There are 4 predefined Profiles: Standard, Streaming 32 kbps, Streaming 64 kbps and
Streaming 128 kbps. Additionally, you can define your own custom Profiles.

If you have selected a Streaming connection as your Primary Profile, the LAN
interface will be running a Streaming connection until you select another
Profile or disconnect the interface. However, if you select one or more
Secondary Profiles, you can set up your Traffic Flow Template so that it will only
use the Streaming Profile for certain types of traffic.

For further information on Profiles and Traffic Flow Templates, see Using Profiles on page 118
and Using a Traffic Flow Template on page 121.

11. Select the Secondary Profile.
To select more than one secondary Profile, press and hold Ctrl or Shift while selecting.

LB |If you have selected both a Primary and one or more Secondary Profiles you must
define a Traffic Flow Template before you can establish a valid connection.

The Context Identifiers (CIDs) for the selected primary and secondary Profiles are listed under
Profile CIDs.

12. Click Apply.
Your LAN settings are applied. Note that changes to your Profiles are not activated until you

click Activate.

13. Click Activate if you want to activate the changes to your Profiles.
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Configuring the Bluetooth interface

For an explanation of each of the data settings, see Description of data settings on page 97.

To configure the Bluetooth interface, do as follows:

L

Select SETTINGS > Interfaces > Bluetooth.
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Under BLUETOOTH VOICE DEVICES, set the voice quality for incoming and outgoing calls. All

paired voice devices are listed with their local phone numbers.
Voice quality is described in more detail in Selecting the call type on page 51.

For Incoming calls, you can check Standard or 3.1 kHz Audio or both.

If you check both, the voice device will react (ring) on incoming calls.

If you select e.g. Standard, the voice device will only react on calls made to the Standard
phone number.

For Outgoing calls, you can select either Standard or 3.1 kHz Audio. The selected quality will
be used by default, if possible, for any outgoing call. Note, however, that fax machines and
modems must use 3.1 kHz Audio.

LEE» | You can override the default setting for outgoing calls by dialing 1* (force a Standard

call) or 2* (force a 3.1 kHz Audio call) before the number. For further information,
see Qverriding the default outgoing call type on page 51.
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3. For data devices, the settings are listed under the Bluetooth profile that is used (Dial-up
network or LAN). The next steps describe the settings available under a Bluetooth profile.

4. Under IP Header compression, select Enabled or Disabled.
For information on Header Compression, see Header compression on page 97.

5. Under TCP/IP, select whether your computer uses a Dynamic IP address or a Static IP address.
If you are using a static address, type in the address.
This is the IP address used externally on the satellite network.
To check this setting on your computer, see the TCP/IP properties of the Bluetooth connection.

6. Under APN, select the source of the APN (Access Point Name).
There are four options for setting the APN. Unless you have special requirements, it is
recommended to use the SIM default, or to set the common APN to SIM default, and then
select Common here. You have the following options:
* Common. The APN is taken from the Common APN defined under
SETTINGS > Interfaces > Common. Refer to Setting a common APN on page 110.

* SIM default. The APN is taken from the SIM card.
* Network assigned. The APN is assigned from the network.
* User defined. Type in the APN. APNs are provided from the Airtime Provider.

7. Ifyour APN uses a password, type in the user name and password provided from the Airtime
Provider.

8. Select the Primary Profile.
Select a Profile from the scroll list. This Profile is used by the Bluetooth interface as a first
choice, when possible.
There are 4 predefined Profiles: Standard, Streaming 32 kbps, Streaming 64 kbps and
Streaming 128 kbps. Additionally, you can define your own custom Profiles.

[LTEREND |1f you have selected a Streaming connection as your Primary Profile, the
Bluetooth interface will be running a Streaming connection until you select
another Profile or turn off the interface. However, you can set up your Traffic
Flow Template so that it will only use this Profile for certain types of traffic.

For further information on Profiles and Traffic Flow Templates, see Using Profiles on page 118
and Using a Traffic Flow Template on page 121.

9. Select the Secondary Profile.

[T |If you have selected both a Primary and one or more Secondary Profiles you must
define a Traffic Flow Template before you can establish a valid connection.

10. Click Apply.
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Pairing Bluetooth devices from the web interface

What is pairing?

Bluetooth Pairing happens when two Bluetooth enabled devices agree to communicate with one
another. When this happens, the two devices exchange passkeys and join a pair. The pairing
process only takes place the first time the two devices are connected. Once the two devices have
established a pair, they automatically accept communication when one device recognizes the
other device.

Preparing the EXPLORER™ 500 for Bluetooth pairing

To prepare the Bluetooth interface on the EXPLORER™ 500, do as follows:

L

2.

Connect a computer to the EXPLORER™ 500, e.g. using the LAN interface.

Access the web interface from your connected computer.
Refer to The web interface on page 74.

In the web interface, select SETTINGS > Interfaces > Bluetooth and make sure that Bluetooth

is Enabled.

o ~m8TE

s 0000000 |
INTERFACE STATUS
Bluatooth interface i Erabled " Disabled

HOME

PHONE EDDK Device Narme IEXPLORER a0o0

MESSAGES Default Passkey |005?3914

CALLS Vizibility Ishow vl

SETTINGS
YOICE DEVICES

Use the predefined Device name or type in a new name for your EXPLORER™ 500.
The Device name is shown to other Bluetooth devices, if the EXPLORER™ 500 is configured to
be shown (refer to step 6. below).

Use the predefined Default passkey or type in a new one.
This passkey is used by default when pairing devices with the EXPLORER™ 500.

Next to Visibility, select Show or Hide.

* If you select Show, the device name of the EXPLORER™ 500 is shown to other Bluetooth
devices that are searching for devices.

* If you select Hide, other Bluetooth devices will not see the EXPLORER™ 500.

Click Apply at the bottom of the window.
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Pairing from your Bluetooth device

For information on how to pair devices from your Bluetooth device, see Pairing devices in which
you can enter a passkey on page 50.

Pairing devices with a fixed passkey

Some Bluetooth devices, such as headsets, do not provide the possibility to enter a passkey for
connecting to another device. These devices have a fixed passkey which must be entered on the
other device. This section describes how to pair such devices with the EXPLORER™ 500.

[T | The method for pairing devices may vary depending on your Bluetooth device. Consult

your Bluetooth device documentation for information.

Do as follows to pair the devices:

L

2.

10.

1L

Connect a computer to the EXPLORER™ 500, e.g. using the LAN interface.

Start up the EXPLORER™ 500.
Refer to Getting started on page 11.

Turn on Bluetooth on your Bluetooth device and place it close to the EXPLORER™ 500.

Access the web interface from your connected computer.
For further information, see The web interface on page 74.

Select SETTINGS > Interfaces > Bluetooth and make sure that Bluetooth is Enabled.

From the left menu of the Bluetooth window, select Add device.

Note that you can pair maximum 7 devices. If you have already paired 7 devices, you have to
unpair a device before you can pair a new one. For information on how to unpair devices, see
Unpairing devices on page 108.

Click Search.
The EXPLORER™ 500 now searches for Bluetooth devices.

[E®» | The search procedure can take up to 2-3 minutes. The list is not updated
dynamically. Click Update to see new found devices.

Click Update.

When the device you want to pair appears in the list, click Pair next to the device.

Enter the passkey of your Bluetooth device.

The default passkey for a Bluetooth headset is often 0000. Otherwise, refer to the manual for

your Bluetooth device.

When you are prompted from the Bluetooth device, usually by a tone, press the button on the
device to accept pairing.
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The new device should now be paired with the EXPLORER™ 500 and added to the list of Paired
devices. This list is accessed from the left menu of the Bluetooth window in the web interface.

As long as the Bluetooth device is in the list of Paired devices, you can always reconnect the
device to the EXPLORER™ 500 without further setup.

Viewing paired devices
To see a list of devices that are paired with the EXPLORER™ 500, do as follows:

1. Access the web interface.
Refer to The web interface on page 74.

2. Select SETTINGS > Interfaces > Bluetooth > Paired devices.

The list shows all devices that are paired with the EXPLORER™ 500. You can see the name, Class
of Device, status (whether or not a device is currently connected) and local phone number.

You can also see paired devices in the display. Select PROPERTIES > BLUETOOTH
DEVICES in the display menu system to see a list of all paired devices.

Unpairing devices
To remove a device from the list of Paired devices, do as follows:

1. Access the web interface and select
SETTINGS > Interfaces > Bluetooth > Paired devices.

2. In the Paired devices list, click Unpair next to the device you want to remove.

[E® |If you need to unpair an EXPLORER™ Bluetooth Handset, make sure the handset is
connected to the EXPLORER™ 500 while you unpair it.

If you select Unpair while the handset is not connected, it will automatically be
paired again when it approaches the EXPLORER™ 500.

When the device is removed from the list, you have to pair it with the EXPLORER™ 500 again to
make a connection.
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Configuring the Phone/Fax settings

Do as follows:
1. Select SETTINGS > Interfaces > Phone/Fax from the left navigation pane.
2. Select Enabled or Disabled to enable/disable the Phone/Fax interface.

3. Set the voice quality for incoming and outgoing calls.
Voice quality is described in more detail in Selecting the call type on page 51.

* For Incoming calls, you can check Standard or 3.1 kHz Audio or both.
If you check both, any device connected to the Phone/Fax interface will react (ring) on
incoming calls.
If you select e.g. Standard, the Phone/Fax interface will only react on calls made to the
Standard phone number.

* For Outgoing calls, you can select either Standard or 3.1 kHz Audio. The selected quality will
be used by default, if possible, for any outgoing call. Note, however, that fax machines and
modems must use 3.1 kHz Audio.

[T | You can override the default setting for outgoing calls by dialing 1* (force the call to
Standard) or 2* (force the call to 3.1 kHz Audio) before the number. For further
information, see Overriding the default outgoing call type on page 51.

4, Click Apply.
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Setting a common APN

Setting the common APN

The common APN setting is defined here and can be selected for each interface. If you are using
the same APN for many interfaces, it is easier to define it once, and then simply select it for the
relevant interfaces. Also, if you change the common APN at a later stage, it is automatically
updated for all interfaces where the Common setting is selected.

To set a common APN, do as follows:
1. Select SETTINGS > Interfaces > Common.

2. Select the APN. You have the following options:

 SIM default. The APN is taken from the SIM card. This is the recommended option, unless
you have special requirements.

* Network assigned. The APN is assigned from the network.
* User defined. Type in the APN. APNs are provided from the Airtime Provider.

3. Ifyour APN uses a password, type in the user name and password provided from the Airtime
Provider.

4, Click Apply.

How to use the common APN

When you configure your individual interface, select Common to use the setting from this window.

Where Common is selected in the individual interface settings, the setting will automatically be
updated when the Common APN is changed.
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Properties, software upload and alarm list

Viewing the properties of the EXPLORER™ 500

To view the properties of the EXPLORER™ 500, select PROPERTIES from the left menu.
The PROPERTIES window shows:
¢ Local IP address. The local IP address of the EXPLORER™ 500.

*  IMEI number. The IMEI number (International Mobile Equipment Identity) of the
EXPLORER™ 500. This is a unique number that identifies your EXPLORER™ 500.

*  SMS service center. A number used to identify the SMS service center used by your
EXPLORER™ 500 to send and receive SMS messages.

*  Mobile subscriber numbers (if available on SIM card). The numbers to use for Standard Voice,
3.1 kHz Audio and data connection when calling the EXPLORER™ 500.

*  Software version. The version of the software embedded in the EXPLORER™ 500.
*  Unit serial number. The serial number of the total unit.

*  PCB numbers. The numbers of the PCBs in the EXPLORER™ 500.

*  MAC address of the EXPLORER™ 500.
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Uploading software

You can upload software to the EXPLORER™ 500 without entering the PIN. However, if the PIN is
not entered, you must enter the Administration user name and password.

To upload software to the EXPLORER™ 500, do as follows:

L

2.

Acquire the new software version from Thrane & Thrane and save it on your computer.

In the web interface, select PROPERTIES from the left navigation pane.
The Software version field shows the current software version.

Click Upload from the left navigation pane.

If you have not entered the PIN at start-up, you are prompted for an Administration user
name and password.

If required, type in the Administration user name and password and click Logon.
The default user name is admin and the default password is 1234.

Thrane & Thrane bgan] iemarsat
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Click Browse...
Browse to the new software version and accept it.

Click the Upload button.
Note that the upload procedure takes a couple of minutes.

[T |When upload is done, your EXPLORER™ 500 automatically restarts with the new
software.
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Viewing the Alarm List

When an alarm is issued, the web interface shows an alarm icon A in the icon bar.

To view the Alarm list, click the alarm icon from the icon bar at the top of the web interface or
select Properties > Alarm list from the left navigation pane.
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The Alarm list window shows a detailed list of active alarms including the time of the first
occurrence, ID and severity of the alarm message, number of occurrences and a short text
describing the error. For more information on the alarm messages, refer to Alarm messages on
page 135.

If you need to report the alarms for service purposes, make sure you include the complete ID
number. This number is used by service personnel to uniquely identify an alarm.
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Administration

Accessing the administration settings

Logging on
The Administration settings require an Administration user name and password.
1. Select ADMINISTRATION from the left navigation pane.

2. Enter the Administration user name and password.
The default user name is admin and the default password is 1234.
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The next section explains how to change the user name and password.

3. Click Logon.
The Administration window is now updated to let you change the user name and password,
Save/load a configuration or log off Administration.
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Changing the administration password

Do as follows:

1. After entering the Administration user name and password in the ADMINISTRATION window,
locate the section Change administrator logon.
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2. Typein the existing user name.
3. Typein the new password twice.
4. Click Change.
At the next logon the new password is required.
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Saving a configuration to a file

If you need to reuse a configuration in another EXPLORER™ 500, you can save your current
configuration to a file, which can then be loaded into the other EXPLORER™ 500.

Do as follows:
1. In the ADMINISTRATION window, under Configuration, click Save.

2. Accept the default destination file name or type in the destination file name and location.

3. Click OK.

The configuration is now saved to a file. This file is used to load the configuration into another
EXPLORER™ 500. See the next section.

Loading a configuration from a file
1. In the ADMINISTRATION window, under Configuration, click Load.

2. Click Browse... to browse to the file you want to import. Then click Open.

3. Click Load.
The new configuration is now loaded into your EXPLORER™ 500.

Logging off administration

If you have not entered anything for 30 minutes under ADMINISTRATION, you are logged off
automatically.

To log off manually, click Logoff under Administrator logoff in the ADMINISTRATION window.
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Call charges

If you know the tariff for your subscribed services, you can enter these tariffs in the web interface
and automatically calculate the charges for your calls and data sessions.

LT | Thrane & Thrane does not take responsibility for the correctness of the estimated

charges. This calculation is only a rough estimate of the charge, based on the tariff
entered by the user. Also, the Airtime Provider may have different methods of calculating
the charge.

Do as follows:

L

Log handling
L

2.

From the left navigation pane, select
ADMINISTRATION > Call Charges

Select the currency from the Currency drop-down list.

Enter the tariff for each of the services.

Click Apply.

The entered tariffs are used for estimating the charges for calls and data sessions. The

estimated charge is listed for each call or data session in the call log. For further information,
see Viewing the lists of calls on page 85.

From the left navigation pane in the ADMINISTRATION window, select Log Handling.
To clear the Call log, click OK next to Clear call log?.

To clear the total counters, click OK next to Clear total counter?.
This will reset the Time connected counters on the Calls page.
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Using Profiles

What is a Profile?

A Profile is a collection of Quality of Service (QoS) settings and other settings defining the mode in
which data is transmitted on an interface. For example, a Profile is used to define whether the
connection is a Streaming connection or a Standard connection.

You can select between a number of predefined Profiles or define your own Profiles for your data
transmission.

If no Traffic Flow Template (TFT) is defined, the Primary Profile for an interface is used for all traffic
on that interface. See What is a Traffic Flow Template? in the next section.

For further information on Profiles, refer to the 3GPP standard TS 23.107.

Selecting the Profiles for an interface
When you set up your interface, you select the Profiles to use for that interface. You select a
Primary Profile and optionally one or more Secondary Profiles.

For further information on how to select the Profiles, see the “Configuring...” sections for the
individual interfaces in this chapter.
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Defining new Profiles

When you define your Profiles you can select Subscribed for many of the settings. If you select
Subscribed, the value given in your Airtime subscription will automatically be used.

To define a new Profile, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Profiles.
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2. Inone of the User defined columns, fill in the top field with the name of your Profile.

3. In the Traffic class row of your new Profile, select a class from the drop-down list.
You may select one of the following:

i

* Conversational is real-time two-way conversation. It is primarily used for voice over IP and

video conferencing.

* Streaming is real-time one-way communication. It is primarily used for video and audio.

* Interactive is two-way communication (not real-time). It is used for communication that is
not very delay-sensitive, such as web browsing, data base retrieval and server access.
Examples of machines interaction with remote equipment are: polling for measurement
records and automatic data base enquiries (tele-machines).

» Background is used for data which is not delay-sensitive, such as E-mails, SMS, download
of databases and reception of measurement records.

[TEIENDY | For best performance, choose the right traffic class for your application. In
general, Standard data (Background) is best suited for TCP/IP applications, and
Streaming data is best suited for UDP traffic, e.qg. live video or audio.
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4. Typein the bit rates in kbps in the following rows:
* Maximum bit rate ul (kbps) is the maximum upload bit rate allowed for this Profile.
* Maximum bit rate dl (kbps) is the maximum download bit rate allowed for this Profile.
* Guaranteed bit rate ul (kbps) is the guaranteed upload bit rate needed for this Profile.
* Guaranteed bit rate dl (kbps) is the guaranteed download bit rate needed for this Profile.

[E®» |When you click Apply, the bit rate values you typed in may be rounded off because
only certain values are allowed.

5. Inthe Delivery order row, select from the scroll list whether or not data should be delivered in
the same order it was sent. Yes means the data packets are delivered in the same order they
were sent.

6. Inthe Maximum SDU size (byte) row, type in the maximum allowed packet size in Bytes
(rounded off to nearest 10). The maximum packet size possible is 1520.

7. In the Delivery of erroneous SDUs row, select one of the following from the list:

* Yes means packets are allowed to contain errors. This setting is suitable for delay-sensitive
transmission, because the need for retransmission is limited. The SDU Error settings in step
8. and step 9. will apply.

* No means packets are not allowed to contain errors, and the SDU Error setting in step 8.
will not be applied. This setting is suitable where error-free transmission is important and
delays are accepted.

* No detect means that errors will not be detected, and the SDU Error setting in step 8. will
not be applied.

8. Ifyou selected Yes in step 7., select from the SDU error ratio drop-down list the fraction of a
packet allowed to be lost or erroneous.

9. Select from the Residual bit error ratio drop-down list the undetected bit error ratio of a
packet. If no error detection is requested, Residual bit error ratio indicates the bit error ratio
in the delivered packets.

10. In the Transfer delay (ms) row, type in the delay in ms. This is the delay from data is received
in the EXPLORER™ 500 until it arrives at the receiving end.

1. In the Traffic handling priority row, select from the drop-down list which priority this
connection should have.

12. Click Apply.
The new Profile is now added, and can be selected from the lists of primary and secondary
Profiles when you set up your interfaces.
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Using a Traffic Flow Template

What is a Traffic Flow Template?

A Traffic Flow Template (TFT) is a packet filter list allowing the Core network and the
EXPLORER™ 500 to classify packets received from the external network into the proper PDP
(Packet Data Protocol) context.

A TFT consists of from one and up to eight packet filters, each identified by a unique packet filter
identifier. A packet filter also has an evaluation precedence index that is unique within all TFTs
associated with the PDP contexts that share the same PDP address.

Information of source, destination, type of service etc. is combined in each packet filter in the TFT.
Purpose of the Traffic Flow Template

The purpose of the TFT is to assign different priorities to different types of traffic, in order to
optimize performance.

Example: When you are browsing the Internet, a Standard data connection will normally be
sufficient. However, if you need to have a video conference, you may need to use a
Streaming connection, in order to obtain a direct connection without interruptions. Your

Traffic Flow Template can define these priorities, so that your connection automatically
switches to Streaming e.g. when you have a video conference.

Defining the Traffic Flow Template
To define a new template, do as follows:

1. From the left navigation pane, select
ADMINISTRATION > Traffic Flow Templates.

2. Select which filters should apply to which Profiles.
The filters are defined in the Traffic flow filters list. Refer to the next section

3. Click Apply.
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Defining filters

for the Traffic Flow Template

To define the filters used in the Traffic flow template, do as follows:

1. From the left navigation pane, select
ADMINISTRATION > Traffic Flow Templates > Traffic flow filters.

Then fillin the details for each traffic flow filter as described below.
2. Typein an Evaluation Precedence Index in the Eval.Prec. Index column.

[E® | This field is mandatory. Each filter must have a different Evaluation Precedence
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3. Fillin one or more of the following fields to define the filter.
The allowed ranges appear in hover text when you pass the mouse over the fields.

Source address + Subnet mask.
Protocol number.

Type

Service

IR AR
ISR RN

Service

Mask

Destination port range (From and To).Note that Source and Destination are relative the core

network. This means that Destination is your EXPLORER™ 500 terminal.

Source port range (From and To).
Type of Service + Type of Service mask.

For further information on the principles and parameters of the Traffic Flow Template, refer to
the 3GPP standards TS27.007 V4.2.0 and TS 23.060 V4.7.0.

4. Click Apply at the bottom of the window.

The new settings are included if you select the filter in the Traffic flow template window.
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Help desk and diagnostic report

Accessing the Help desk

If you need help with airtime-related issues you may call the Help desk. By default, the Help desk
is the phone number for your Airtime Provider, if it is available on the SIM card.

Select HELP DESK from the left navigation pane.

If the Help desk number is available on the SIM card, the number is displayed as a link. To change
the number, click the link, change the number and click Apply.

If you need help with EXPLORER™ 500 issues you should call your local distributor.

Generating a diagnostic report

If you want to generate a diagnostic report, do as follows:

1. Click Generate report from the HELP DESK window.
In some browsers the file may open directly in your browser. If it does, choose File > Save As
to save the file.

2. Choose a location for the file and save it.

The diagnostic report contains relevant information for troubleshooting. Please enclose this file
when you are reporting an error.

What's next?

This chapter has explained how to use the web interface for setup and use of the EXPLORER™ 500.
You should now be able to set up the EXPLORER™ 500, pair Bluetooth devices, check status, read
and send SMS messages, use the phone book and much more.

The following chapter, Maintenance and troubleshooting, provides guidelines for troubleshooting
and for general maintenance.
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Maintenance and troubleshooting

In this chapter

This chapter gives guidelines for troubleshooting and for general maintenance. It also provides an
overview of the different means of status signaling,

Getting support

Overview

If this manual does not provide the information required to solve your problem, you may want to
contact your Airtime Provider or your local distributor.

Airtime support

If you need assistance from your Airtime Provider, please call the help desk.

To see the help desk number, enter the display menu system or the web interface of your
EXPLORER™ 500 and select HELP DESK. This help desk number is either taken from the SIM card
or entered manually. If no number is available under HELP DESK, check your Airtime subscription
for a contact number.

EXPLORER™ 500 support
If you need assistance with problems caused by the EXPLORER™ 500, please call a distributor in
your area.

Click this link to see a list of Thrane & Thrane distributors.

L™ | The list of distributors is located on the EXPLORER™ 500 CD-ROM delivered with your
EXPLORER™ 500, so it may not always be up to date.

An updated list is available on Thrane & Thrane’s web site: www.thrane.com.
Click Land Mobile and select Distributors from the top menu bar.
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Uploading software

Viewing software version status

To view the version of the embedded software in the EXPLORER™ 500, select PROPERTIES in the
web interface or in the display menus and see Software information.

Uploading software using the web interface

You can upload software from the PROPERTIES > Upload window in the web interface.

If you have an Administrator user name and password you do not need to insert a SIM card nor to
enter the PIN to be able to upload software.

For further information, see Uploading software on page 112.
Maintenance

Normal use of the battery

It is recommended not to partially charge/discharge the battery several times in a row. Partial
charging/discharging affects the accuracy of the capacity measurement.

Never leave the battery fully discharged for a longer period of time. If the battery is not to be used
for a shorter period of time (1 month), charge the battery to minimum 20 to 30% and remove it
from the EXPLORER™ 500. If the Battery is stored for more than a month, see Storage at the end of
this section.

Recharging the battery

To recharge the battery, insert it into the EXPLORER™ 500 and connect the EXPLORER™ 500 to
power.

The indicator left to the display is constantly green as long as the battery is charging. When the
battery is fully recharged, the green indicator is turned off. If the EXPLORER™ 500 is switched on,
the green indicator will be flashing shortly every 2 seconds.

If a charging error occurs, the green indicator on the EXPLORER™ 500 flashes rapidly. See the
Troubleshooting Guide on page 128.
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Accurate display of the battery capacity

Storage

To ensure accurate display of the battery capacity, it is recommended to run a “learning cycle” for
every 100 recharge/discharge and at first time use. The learning cycle must be performed at 20°C-
30°C.

A learning cycle is performed as follows:
1. Fully charge the battery.

2. Remove external power and fully discharge the battery:
Use the EXPLORER™ 500 and/or leave it on until it turns off automatically.
This way the EXPLORER™ 500 “learns” the complete capacity of the battery.
Note that it may take up to 36 hours to discharge the battery if it is not in use.

3. Recharge the battery.

Do not leave the battery inserted in the EXPLORER™ 500 during storage.

If the battery is not to be used for a longer period of time, do as follows:
1. Fully charge the battery.

2.  Remove external power. Then use the EXPLORER™ 500 or leave it on until the display shows a
battery capacity of approximately 50%.

3. Switch off the EXPLORER™ 500.

[ Important 2 ‘Switch off the EXPLORER™ 500 before removing the battery!

4. Remove the battery and store it.

In this condition the battery can be stored for approximately 1year at 20°C to 30°C. After 1 year you
must recharge the battery. For further information on storage temperature, see Battery on
page 142.

Disposal of the EXPLORER™ 500

0Old electrical and electronic equipment marked with this symbol can
contain substances hazardous to human beings and the environment.
Never dispose these items together with unsorted municipal waste
(household waste).

In order to protect the environment and ensure the correct recycling of old equipment as well as
the re-utilization of individual components, use either public collection or private collection by the
local distributor of old electrical and electronic equipment marked with this symbol.

Contact the local distributor for information about what type of return system to use.
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Options and accessories

The following options and accessories are available from Thrane & Thrane:

Item

Number

EXPLORER™ Bluetooth Handset + charger cable

TT-3625A

Desktop charger cradle for EXPLORER™ Bluetooth
Handset + power supply

TT-3625A, Opt. 003

EXPLORER™ 500 Battery

TT-3686L

EXPLORER™ External antenna + antenna cable

TT-30081

Pole mount kit for EXPLORER™ 500 External antenna

TT-3650A, Opt. 920

EXPLORER™ 500 Softhag

TT-3650A, Opt. 202

TT-3686F

EXPLORER™ 500 Car charger cable

EXPLORER™ 500 Dummy Battery I

TT-3650A, Opt. 009

Pole mount kit for EXPLORER™ 500

TT-3650A, Opt. 922

AC/DC adapter

e 5

TT-3682L
UP0501Q-15P
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Troubleshooting guide

The below table provides information on some of the problems that might occur, including

possible causes and remedies to solve the problems.

Problem

Possible Cause

Remedy

The EXPLORER™ 500
cannot be switched
on, or does not stay
on when powered by
the battery.

The battery needs
recharging.

Recharge the battery. Check the battery
indicator in the display.

The battery is not inserted
properly.

Remove the battery and re-insert it.
Make sure the battery is inserted
properly and that the latch is locked.

The battery contacts are
dirty or damaged.

Clean the battery contacts if necessary.
If the contacts are damaged, replace the
battery.

There is no lightin
the power indicator
norin the display
when the
EXPLORER™ 500 is
switched on.

The EXPLORER™ 500 may
be in Stealth Mode (all
lights and sounds are off).

Press C+OK on the display keypad. This
will toggle Stealth Mode on/off.

The EXPLORER™ 500
cannot be switched
off.

The Power button was not
pressed long enough.

When you switch off the
EXPLORER™ 500, hold the power
button until the display shows
“Switching off”.

In rare cases, it may take up to 10
seconds to switch off the
EXPLORER™ 500.

Charging error -

The green Power
indicator flashes
rapidly while the
battery is being
recharged.

The temperature is below
0°C or above 45°C.

Only charge the battery when the
temperature is within the range 0°C to
45°C.

The charging voltage is
less than 9 V.

Wait until charging begins (the green
Power indicator lights constantly).

If the battery is completely discharged,
and it has been out of use for a long
time, the charging process may take a
long time to start. If charging does not
begin within 2-3 hours, contact your
local distributor, or purchase a new
battery.
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Problem

Possible Cause

Remedy

The display shows
INSERT SIM.

The SIM card is not
present.

Remove the battery and insert the SIM
card in the SIM slot according to the
instructions in the section Inserting the
SIM card on page 12.

The SIM card is not
inserted properly.

Remove the SIM card and re-insert it
according to the instructions in the
section Inserting the SIM card on
page 12.

The display shows
NO GPS.

The EXPLORER™ 500 is
unable to register on the
network, because the GPS
position is unknown.

Make sure the view to the GPS satellites
is not blocked.

To obtain GPS fix, the EXPLORER™ 500
should be placed flat on an even
surface pointing straight upwards, with
a clear view to as much of the sky as
possible. When the EXPLORER™ 500
has obtained GPS fix, you can point the
antenna towards the BGAN satellite.

To see the GPS status, enter the menu
system and select PROPERTIES >
GPS STATUS.

The display shows
EMERGENCY
ONLY.

The BGAN network is only
available for emergency
calls.

The reason may be one of
the following:

1) You have pressed C on
the EXPLORER™ 500
instead of entering the PIN.

2) Your Airtime
subscription has expired.

3) You are using the wrong
SIM card.

1) If the display reads “ENTER PIN?”
and/or you cannot enter the display
menu system, you may have pressed C
instead of entering the PIN. Unless the
use of PIN is disabled, e.g. from the
BGAN LaunchPad, you must enter the
PIN before you are allowed make calls.

2) Check your subscription with the
Airtime Provider.

3) Check that your SIM card is valid for
communication on the BGAN network.

The display shows
NOT
REGISTERED.

The EXPLORER™ 500
cannot register on the
BGAN network.

Check that your SIM card is valid for
communication on the BGAN network.

Check your subscription with the
Airtime Provider.
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Problem

Possible Cause

Remedy

The EXPLORER™ 500
cannot obtain its
position using GPS.

There is no GPS signal, or
the signal is weak.

If the EXPLORER™ 500 has
not been used recently
within the same location, it
can take up to 10 minutes
to obtain the GPS position.

Check the GPS status in the display or
the web interface.

To help the EXPLORER™ 500 obtain
GPS fix, it should be placed flat on an
even surface pointing straight upwards,
with a clear view to as much of the sky
as possible.

When the EXPLORER™ 500 has
obtained GPS fix, you can point the
antenna towards the BGAN satellite.

No signal or weak
signal from the BGAN
satellite.

The view to the satellite is
blocked.

Make sure the EXPLORER™ 500 has a
clear view to the satellite. Be aware that
window glass, trees, or even rain may
reduce the signal level.

The antenna is pointed in
the wrong direction.

Check that the antenna is pointed
according to the position data.

Adjust the position to the highest
possible signal strength.

Connection to the
Internet cannot be
established.

The signal strength is too
low.

Check that the antenna is pointed
according to the position data.

Adjust the position to the highest signal
strength you can obtain.

As a rule of thumb, you should have a a
signal strength of 45 dBHz or more to
be able to make a call or data session.

Your connection is defined
as a dial-up connection,
but you have not opened
the dial-up connection.

You need to open the dial-up
connection before you can connect to
the Internet.

Your connection is a dial-
up connection, but you
have not entered the
phone number *98# to
indicate a connection to
the Internet.

Change the phone number in the dial-
up connection to *98# and open the
dial-up connection before accessing the
Internet.
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Problem

Possible Cause

Remedy

The web interface
cannot be accessed.

The browser is configured
to use a proxy server.

For Microsoft Internet Explorer, select
Tools > Internet Options > Connections >
LAN Settings and uncheck Use a proxy
server for your LAN.

You have entered a wrong
IP address.

Check the IP address and re-enter it.

Your connection is defined
as a dial-up connection,
but you have not opened
the dial-up connection.

You need to open the dial-up
connection before you can connect to
the Web server.

Your connection is a dial-
up connection, but you
have not entered the
phone number *98# or
*994# to indicate
connection to the Internet
and/or the web interface.

Change the phone number in the dial-
up connection to *98# or *99# and
open the dial-up connection before
accessing the web interface.

A Phone/Fax
connection cannot be
established.

The interface is disabled in
the EXPLORER™ 500.

Enable the interface by entering the
display menu system and selecting
SETTINGS > INTERFACES >
PHONE /FAX > ON, or

by accessing the web interface and
selecting SETTINGS > interfaces >
Phone/Fax > Enabled

The cable is not properly
connected.

Connect the cable.

The cable type or
connector type is not
correct.

For information on the correct type of
connector and cable, refer to Phone/Fax
interface on page 144.

Incoming calls: The voice
quality used for the call is
not selected in the web
interface.

Make sure the voice quality used for
calls to the EXPLORER™ 500 is selected
in the web interface. Access the web
interface and select SETTINGS>
Interfaces > Phone/Fax. Then select the
voice quality for incoming calls.
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Problem

Possible Cause

Remedy

A Bluetooth handset
connection cannot be
established.

The interface is disabled in

the EXPLORER™ 500.

Enable the interface by entering the
display menu system and selecting
SETTINGS > INTERFACES >
BLUETOOTH > ON, or

by accessing the web interface and
selecting SETTINGS > interfaces >
Bluetooth > Enabled

The Bluetooth handset is
placed too far away from
the EXPLORER™ 500.

Bring the handset closer to the
EXPLORER™ 500.

Note that the specified maximum
distance is only valid under ideal
conditions.

The handset is not yet
paired with the
EXPLORER™ 500.

Pair the devices. Refer to Pairing
devices in which you can enter a
passkey on page 50.

Incoming calls: The voice
quality used for the call is
not selected in the web
interface.

Make sure the voice quality used for
calls to the EXPLORER™ 500 is selected
in the web interface. Access the web
interface and select SETTINGS >
Interfaces > Bluetooth. Under
BLUETOOTH VOICE DEVICES locate the
relevant handset and select the right
voice quality for incoming calls.

A LAN connection
cannot be
established.

The interface is off in the
EXPLORER™ 500.

Enable the interface by entering the
display menu system and selecting
SETTINGS > INTERFACES > LAN >
ON, or

by accessing the web interface and
selecting SETTINGS > interfaces > LAN >
Enabled

The cable is not properly
connected.

Connect the cable.

The cable type or
connector type is not
correct.

For information on the correct type of
connector and cable, refer to LAN
interface on page 145.
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Problem

Possible Cause

Remedy

A USB connection
cannot be
established.

The cable is not properly
connected.

Connect the cable.

The cable type or
connector type is not
correct.

For information on the correct type of
connector and cable, refer to USB
interface on page 146.

The dial-up connection is
not created correctly.

Refer to Creating a dial-up connection
on page 70.

The Thrane & Thrane
EXPLORER™ USB driver is
not installed.

Install the driver as described in First
time setup of USB on page 66.

The USB connection uses a
wrong COM port.

port to which the Thrane & Thrane
EXPLORER™ USB driver is assigned.

In Windows XP, open your dial-up

Thrane EXPLORER™ USB driver is
selected.

If not, click Configure and select the
Thrane & Thrane EXPLORER™ USB
driver.

Make sure the connection uses the COM

connection and select Properties. Under
Connect using: check that the Thrane &
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Problem

Possible Cause

Remedy

A Bluetooth data
connection cannot be
established.

The interface is off in the
EXPLORER™ 500.

Enable the interface by entering the
display menu system and selecting
SETTINGS > INTERFACES >
BLUETOOTH > ON, or

by accessing the web interface and
selecting SETTINGS > interfaces >
Bluetooth > Enabled.

The computer is placed too
far away from the
EXPLORER™ 500.

Bring the computer closer to the
EXPLORER™ 500.

Note that the specified maximum
distance is only valid under ideal
conditions.

The computer is not yet
paired with the
EXPLORER™ 500.

Pair the devices. Refer to Bluetooth
pairing on page 50.

The requested Bluetooth
profile is not supported, or
is not activated on the
computer.

Check the Bluetooth installation on your
computer to see if the profile is
supported and activated.
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Status signaling

There are many ways of troubleshooting if an error occurs. The EXPLORER™ 500 has different
means of status signaling, to help you find the cause of a problem:

* Indicators.
The function of the light indicators next to the
display is described in Light indicators on page 8.

[a]
BT «& & B
READY :

| s |

*  Alarm messages.
* Log files.

Alarm messages and log files are described in the following sections.

Alarm messages

Display of alarm messages

The EXPLORER™ 500 can detect errors during POST (Power On Self Test) or CM (Continuous
Monitoring). When the EXPLORER™ 500 detects an error that requires your action, it issues an

alarm.
o o]
1 ALARM
PENDING

When alarms are issued in your EXPLORER™ 500,
S P

the display indicates the number of new alarms, and
the red message indicator is flashing.

You now have the following options:

*  Press Ctoignore the alarm message and
continue from where you were before the alarm was issued.

*  Press OK to enter the alarm list showing all active alarms. The alarms are listed with their ID
numbers.
To see the name and time stamp of the alarm, press OK again.
Use A and V¥ to scroll through the name, ID and time stamp. If the text is too long, press OK
(») to scroll through the rest of the text.

As long as the cause of an alarm is still present, the Main screen shows VIEW ALARM LIST?
If you press 0K, the list of currently active alarms appears.

Explanations for the alarms and remedies to solve the problems are listed in the next section.

All alarms are logged in the alarm log. For information on the alarm log, see Alarm log on
page 140.
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List of alarms

The following list explains the alarms that may show in the display and in the web interface of the
EXPLORER™ 500.

LT |In the display and in the web interface the ID includes a hyphen followed by a control-
digit at the end. This digit is used to make sure the ID is not misinterpreted when passed
on, e.g. to service personnel. Make sure you include the entire number when contacting
your distributor.

ID Alarm Text Explanation Remedy
00100to | System Data Important system data is Do not use the
00199 Damaged damaged EXPLORER™ 500. Contact
your distributor.
00200to | Battery Error Error during Only use the
00209 communication with the EXPLORER™ 500 with
battery external power supply.
Contact your distributor.
00210to | SIM Module The SIM interface on the Contact your distributor.
00219 Error EXPLORER™ 500 cannot be
used.
00220to | USB Module The USB interface on the Contact your distributor.
00229 Error EXPLORER™ 500 cannot be
used.
00230to | Temperature The system is in danger of | Do not use the
00239 Sensor FATAL overheating. EXPLORER™ 500. Contact
your distributor.
00240to | Temperature Automatic adjustment of Contact your distributor.
00249 Sensor Error the display contrast does
not work.
00250to | Bluetooth Bluetooth cannot be used. | Contact your distributor.
00259 Module Error
00260to | System Error The EXPLORER™ 500 Contact your distributor.
00269 cannot communicate on
the satellite network.
00270to | Voice Module Voice services cannot be Contact your distributor.
00279 Error accessed by the
EXPLORER™ 500
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1D Alarm Text Explanation Remedy
00280to | Ethernet The Ethernet interface on Contact your distributor.
00289 Module Error the EXPLORER™ 500
cannot be used.
00290to | Power Supply Power on/off, charging Contact your distributor.
00299 Error and/or LED control may be
out of function.
00300to | GPS Module The GPS module is out of Contact your distributor.
00309 Error function. The
EXPLORER™ 500 cannot
obtain a valid GPS position.
01000to | Temperature Low ambient temperature Move the EXPLORER™ 500
01009 Too Low is causing the performance | to a warmer location.
of the EXPLORER™ 500 to For information on
be degraded or halted. temperature limits, see
General specifications on
page 141
0ll00to | Temperature High ambient temperature | Move the EXPLORER™ 500
01109 Too High is causing the performance | to a cooler location.
of the EXPLORER™ 500 to For information on
be degraded or halted. temperature limits, see
General specifications on
page 141,
01200to | Battery Level The battery is running out | Recharge the battery or
01209 Low of power. replace it with a new one.
01300to | No GPS Fix The GPS receiver has not Make sure the view to the
01309 yet achieved position fix. GPS satellites is not
blocked.
To help the
EXPLORER™ 500 obtain
GPS fix, it should be placed
flat on a surface pointing
straight upwards, with a
clear view to as much of the
sky as possible.
Note that in some cases it
may take up to 10 minutes
to obtain GPS fix.

TT 98-122274-M

137




Chapter 6: Maintenance and troubleshooting

1D Alarm Text Explanation Remedy
01400to | Satellite The EXPLORER™ 500 no Make sure the

01409 Signal Lost longer receives a signal EXPLORER™ 500 has a

from the satellite. clear view to the satellite.
Check that the antenna is
pointed according to the
position data.

01500to | SIM Card No SIM card is detected in | Insert SIM card.

01509 Missing the SIM slot. If the SIM card is already
inserted, try removing and
reinserting it.

01600to | SOS Calls Only | The SIM card is not Enter the PIN and wait for

01609 accepted by the network. network approval. If the

Only emergency calls are problem persists, contact
allowed. your Airtime Provider.
01700to | Registration The EXPLORER™ 500 has If the problem persists,

01709 For Voice not yet been allowed to contact your Airtime

Failed register for voice services Provider.
(Circuit Switched).
01800to | Registration The EXPLORER™ 500 has If the problem persists,
01809 For Data not yet been allowed contact your Airtime
Failed register for data services Provider.
(Packet Switched).
01900to | Temperature The temperature is too low | If charging is needed, move
01909 Too Low For for the battery charger to the EXPLORER™ 500 to a
Charging operate. warmer location. The
temperature must be above
0°C/+32°F for the battery
charger to operate.
02000to | Satellite The signal from the Check the line of sight to

02009 Signal Weak satellite is weak. the satellite. Be aware that
window glass may reduce
the signal level.

Check that the antenna is
pointed according to the
position data. Adjust the
position to the highest
possible signal strength.
02100to | Ciphering Off The network has turned Do not transmit data that
02109 ciphering off. requires ciphering.
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1D Alarm Text Explanation Remedy
02200to | Ethernet Ethernet data session could | See the display call log for
02209 Connection not be established. the cause of the error.
Failed Refer to Calls menu on
page 38.
If the problem persists,
contact your distributor.
02300to | External The EXPLORER™ 500 is not | Correct communication
02309 Antenna able to detect the external | with the satellite requires
Failure antenna type. an original Thrane &
The reason may be one of | TNrane antenna.
the following: If you are already using an
. original Thrane & Thrane
*  You are not using an .
.. antenna when you see this
original Thrane &
alarm, contact your
Thrane antenna L
distributor for support.
* The antennais
defective
02400to | Invalid The EXPLORER™ 500 is not | The EXPLORER™ 500
02409 Battery able to detect the battery requires an original Thrane
type. & Thrane battery.
The reason may be one of | If you are already using an
the following: original Thrane & Thrane
v . battery when you see this
*  You are not using an
.. alarm, contact your
original Thrane & distributor f ¢
Thrane battery istributor for support.
*  The battery is defective
02800to | Antenna The EXPLORER™ 500 is not | Do not use the terminal.
02809 Failure able to detect the state of Contact your distributor.
the antenna relay.
02400to | Bluetooth The list of paired Bluetooth | Unpair a paired device to
02409 Device devices is full. The make room for a new one.
Database Full EXPLORER™ 500 doe§ not | Forinformation on how to
alloyv more than 7 paired unpair devices, see
devices. Unpairing devices on
page 108.
02900to | Network failed | The EXPLORER™ 500 does | Restart the
02909 authentication | notacceptthe networkasa | EXPLORER™ 500.
valid BGAN network. If the problem persists,
contact your distributor.
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Log files

Note

When contacting Thrane & Thrane for support, please include a diagnostic report.
The diagnostic report contains information relevant for the service personnel during
troubleshooting.

To generate the diagnostic report, access the web interface and select Help Desk. Then click
Generate report.

Alarm log

The alarm log holds information of all alarms issued by the EXPLORER™ 500.

The log includes the time of the error, a short description, location of the error etc. This
information can help troubleshooting errors in the EXPLORER™ 500. The Alarm log is not
accessible from the user interface, but is included when you generate a diagnostic report. For
information, see Help desk and diagnostic report on page 123.

Call log

The call log holds information of up to 100 calls and data sessions to/from the EXPLORER™ 500.

The call log contains detailed information such as date, time, phone numbers, duration, Mb
transferred etc., for each call or data session.

Date and time is UTC time, received from the satellite.

For information on how to view the call log in the display, see Calls menu on page 38.
LT | The call log in the display shows information on voice calls but not on data sessions.

For information on how to view the call log in the web interface, see Viewing the lists of calls on
page 85.
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Technical specifications

In this appendix

This appendix contains technical specifications for the EXPLORER™ 500 and information on

Conformity.

General specifications

The EXPLORER™ 500 meets or exceeds current and proposed Inmarsat specifications for operation
on the Inmarsat Broadband Global Area Network.

Item

Specification

Type

EXPLORER™ 500, BGAN Class 2 Terminal

Max. data rate®
Downlink
Uplink

Streaming IP

464 kbps (shared)
448 kbps (shared)
32, 64, 128 kbps

Physical dimensions

218 mm x 216 mm x 52 mm/
8.6” x8.5” x 2.0”

Weight (including Battery)

1.4 kg/3.11lbs

Environmental conditions

Operating temperature
Powered by external DC
Powered from battery

Storage temperature
Without battery
With battery

Relative humidity
Water & Dust
Max. wind-load

-25°C to +55°C/-13°F to +131°F
0°C to +55°C/+32°F to +131°F

-40°C to +80°C/-40°F to +176°F
-20°C to +60°C/-4°F to +140°F

95% non-condensing at +40°C/+104°F
IP-54 (dust and spray proof in all directions)
18 m/s or 59 ft/s (Operational)

Robustness

0.5 m/1.64 ft drop on concrete (Operational, 95% survival)

Supported web browsers
(Other browsers may be
supported as well, but only
these have been tested.)

Microsoft Internet Explorer 6.0
Mozilla Firefox 1.0
Apple Safari 2.0

a. Performance depends on a wide range of factors and actual usage.
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Premium voice call®
Download Streaming 128 kbps
Upload Streaming 128 kbps

Battery
Specifications
Item Specification
Battery type Lithium ion, rechargeable
Voltage 1.1V
Capacity 2.2 Ah
Time between recharging
Standby time® 36 hours
Standard call® 3 hours

1 hour 30 minutes
3 hours 30 minutes

2 hours 15 minutes

Charge time®

Less than 3 hours
(when the EXPLORER™ 500 is switched off)

Charge temperature

0°C to +45°C/+32°F to +113°F Ambient

Min. charge cycles

300

Storage temperature
1 Month
3 Months
1Year

-20°C to +60°C/-4°F to +140°F Ambient
-20°C to +45°C/-4°F to +113°F Ambient
-20°C to +20°C/-4°F to +68°F Ambient

a. Performance depends on a wide range of factors and actual usage.
b. With either Bluetooth or Phone interface.
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Power input

Connector pin-out

This drawing shows the pin-out for the DC Power +
connector.
GND
Specifications
Item Specification

DCinput range

+10 to +16 V DC

Power consumption?
Standby mode
Transmit mode
During charging

0.8 W (Typical)
14 W (Typical)
38 W max.

Connector type

Proprietary DC Jack, 2.5 mm, positive center

a. Performance depends on a wide range of factors and actual usage.

AC/DC adapter, UP0501Q-15P

Item

Specification

ACinput range

100 to 240 V AC, 47 to 63 Hz

DC output 15V DC 50 W
SIM interface
Specifications
Item Specification
Slot type Standard SIM card holder
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Phone/Fax interface

Connector pin-out

The pin-out for the Phone/Fax connector is as follows:

RJ-11 Connector Pin =i e
1234

1 | NC
2 | Tip
3 | Ring

Female (Receptacle) 4 NC

Specifications
Item Specification

Connector type

R]-11, female

Impedance 180 Q + 750 ©/150nF
Max. cable length 100 m/80 Q2
Max. units connected One unit
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LAN interface

Connector pin-out

The pin-out for the LAN connector is as follows:

RJ-45 Connector Pin | Function
12345678 1 | Rx+
2 | Rx-
3 | Tx+
b~ | NC
Female (Receptacle) 5 NC
6 | Tx-
7 | NC
8 | NC
Specifications
Item Specification

Connector type

R]-45, female, MDI-X (IEEE 802.3 10/100BaseT)

Standard

ISO/IEC 8877:1992 and
IEEE 802.3 1998 Edition

Max. data rate

10/100 Mbps

Max. cable length

100 m/328 ft with Cat5 UTP
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USB interface

Connector pin-out

The pin-out for the USB connector is as follows:

Mini-B Pin Function
12 3 4 5 1 | NC
=Jia:
3 | D+
Female (Receptacle) 4 NC
5 | GND
Specifications
Item Specification
Version 1.1 (Slave)
Connector type Mini-B, female
Max. data rate 12 Mbps
Max. cable length 5 m/16.4 ft
Max. units connected 7 physical devices
Driver Proprietary, enclosed on CD with the product
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Bluetooth interface

Specifications
Item Specification
Version 1.2
Standard Power Class 1.
The Class 1interface also supports Class 2 and Class 3
peripherals if they support RSSI (Received Signal Strength
Indicator).
Antenna Integrated in transceiver unit
Physical media Frequency-Hopping Spread Spectrum RF
Max. data rate 721 kbps + 57.6 kbps
Frequency 2400 to 2483.5 MHz
Max. coverage outdoor? 100 m/328 ft
Max. number of devices 7
connected
Profiles supported Cordless Telephony Profile (CTP)
Service Discovery Application
Serial Port Profiles (SPP):
* Dial-up Networking (DUN)
* LAN Access Profile (LAP)
* Headset Profile (HSP)

a. Performance depends on a wide range of factors and actual usage.
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Built-in antenna

Specifications
Item Specification
Type Directional patch array, manually adjustable
Polarization RHCP
Frequencies
Inmarsat
Transmit 1626.5 to 1660.5 MHz
Receive 1525.0 to 1559.0 MHz

Bearer bandwidth

200 kHz

GPS 1575.42 MHz
Bluetooth 2400.0 to 2483.5 MHz
EIRP 15.1dBW 1 dB

Power steps

01to 10 dBin 1dB steps
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External antenna

Connector pin-out

This drawing shows the pin-out for the Signal

external antenna connector on the

EXPLORER™ 500. GND
Specifications

[LTENEND | Only use the specified antenna from Thrane & Thrane. The antenna is listed in
Options and accessories on page 127.

Item Specification
Type Directional patch array, manually adjustable
Polarization RHCP
Connector type 50 Q2 QLA (female)
Frequencies
Inmarsat
Transmit 1626.5 t0 1660.5 MHz
Receive 1525.0 to 1559.0 MHz
Bearer bandwidth 200 kHz
GPS 1575.42 MHz
EIRP 15.1dBW +1dB
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EXPLORER™ Bluetooth Handset charger interface

Connector pin-out

This drawing shows the connector for the EXPLORER™ Pin 2 Pin 1

Bluetooth Handset charging interface.

The connector is placed at the back of the
EXPLORER™ 500. Pin 11is the pin closest to the coding
projection on the plastic insert.

Specifications
Item Specification
Connector type Proprietary
Output 6.4 V/350 mA
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Serial number label

The following label is placed on the EXPLORER™ 500.

TT-3710A EXPLORER 500 S/N: XXXXXXXX

P/N 403710A Rev.: X Prod.: Year/Week
[FCC ID ROJEXPLORER-500| IMEL XXXXXXXXXX
This device complies with part 15 of the

FCC Rules. Operation is subject to the following c € @

two conditions: (1) This device may not cause

harmful interference, and (2) this device must

accept any interference received, including QCS
interference that may cause undesired operauon

Thrane &Thrane A/S Denmark

“Xes” are replaced by the relevant numbers for the specific terminal.
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Conformity

CE (R&TTE)
The EXPLORER™ 500 is CE certified (R&TTE directive) as stated in “Declaration of Conformity with
R&TTE Directive”, enclosed in electronic copy on the next page.
Use of Bluetooth:

Thrane & Thrane have sent notification to all countries in the EU for use of the Bluetooth interface.
Individual license may be required in some countries outside the EU and USA.

For use in the EU, the following restrictions apply:

France: Outdoor use must be limited to 10 mW EIRP within the frequency band 2454 MHz to
2483.5 MHz.

Italy: Outdoor use outside own premises require general authorization.

FCC

This device complies with part 15 of the FCC Rules. Operation is subject to the following two

conditions:

1) This device may not cause harmful interference, and

2) this device must accept any interference received, including interference that may cause

undesired operation.

Part 15.21

Changes or modifications not expressly approved by the party responsible for compliance could

void the user's authority to operate the equipment.

LT | The manufacturer is not responsible for any radio or TV interference caused by
unauthorized modifications to this equipment. Such modifications could void the user's
authority to operate the equipment.

GMPCS

The EXPLORER™ 500 has obtained the GMPCS-MoU mark.
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Thrane & Thrane

Thrane & Thrane A/S

Declaration of Conformity with R&TTE Directive

The undersigned of this letter declares that the following equipment complies with the
specifications of EC directive 1999/5/EC concerning Radio & Telecommunications Terminal

Equipment.

Equipment included in this declaration

TT-3710A EXPLORER™ 500 PN = 403710A
TT-3682L AC/DC Adapter PN = 403682L (UP0501Q-15P)

Equipment Applicability

The TT-3710A EXPLORER™ 500 is a mobile terminal that provides voice, fax or high-speed data
communication through the Inmarsat satellite service world wide between a mobile terminal and
any destination in the world. Only the Bluetooth interface of the terminal has restrictive use in
France and ltaly in EU. The Inmarsat interface to a satellite has no restriction in use. See User
manual for further information.

Declaration

The safety requirement with respect to the LVD directive 73/23/EC is met by conforming to the
harmonized EU standard EN 60950. The protection requirement with respect to the EMC
directive 89/336/EC is met by conforming to the harmonized EU standards ETSI EN 301489-1,
ETSI EN 301489-17 and ETSI EN 301489-20. Effective use of frequency spectrum is met by
conforming to the harmonized EU standards ETSI EN 301444 and ETSI EN 300328.

Manufacturer
Thrane & Thrane A/S, Lundtoftegardsvej 93D, DK-2800 Kgs. Lyngby, Denmark

Place and Date

Kgs. Lyngby, 11. May 2006
i €O

Henrik Lunde, CEO

Doc. no. 99-122652-D 1. Page: 1 of 1
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Appendix B

AT commands

In this appendix

This appendix contains a list of AT Commands for the EXPLORER™ 500.

Starting up an AT command session

Set up your computer to use either the USB or Bluetooth interface. For further information, see
Using the USB interface on page 66 or Using a computer with Bluetooth on page 69.

Connect your computer to the USB or Bluetooth interface of the EXPLORER™ 500 and launch your
terminal program.

The following section contains a list of commands that can be used with the EXPLORER™ 500. For
further information on the AT commands, refer to the following standards:

* ITUV.250 Serial asynchronous automatic dialing and control

*  3GPP TS 27.005 ver. 4.2.0, Use of Data Terminal Equipment - Data Circuit terminating
Equipment (DTE-DCE) interface for Short Message Service (SMS) and Cell Broadcast Service
(CBS)

*  3GPP TS 27.007 ver. 4.6.0, AT command set for User Equipment (UE)
3GGP standards are found on www.3gpp.org

ITU standards are found on www.itu.int

TT 98-122274-M 154


http://www.3gpp.org
http://www.itu.int

Appendix B: AT commands

List of supported AT commands

Command Function

ATA Answer

ATD Dial

ATE Command echo

ATH Hang up

ATI Request identification information

ATL Monitor speaker loudness

ATM Monitor speaker mode

ATN Automode control

ATP Select pulse dialing (command)

ATQ Result code suppression

ATS Set register

ATT Select tone dialing (command)

ATV DCE response format

ATX Result code selection and call progress monitoring control
ATZ Reset to default configuration

AT&C Circuit 109 (Received line signal detector) behavior
AT&D Circuit 108 (Data terminal ready) behavior
AT&F Set to factory defined configuration

AT&V Display active and stored profile

AT&W Store profile

AT+CACM Accumulated call meter

AT+CAEMLPP eMLPP priority registration and interrogation
AT+CALM Alert sound mode

AT+CAMM Accumulated call meter

AT+CAOC Advice of charge
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Command Function

AT+CBC Battery charge

AT+CBST Select bearer service type

AT+CCFC Call forwarding number and conditions
AT+CCLK Clock

AT+CCUG Closed user group

AT+CCWA Call waiting

AT+CCWE Call meter maximum event

AT+CDIP Called line identification presentation
AT+CEER Extended error report

AT+CFCS Fast call setup conditions

AT+CFUN Set phone functionality

AT+CGACT PDP context activate or deactivate
AT+CGATT PS attach or detach

AT+CGCLASS GPRS mobile station class
AT+CGCMOD PDP context modify

AT+CGDATA Enter data state

AT+CGDCONT Define PDP context

AT+CGDSCONT Define secondary PDP context
AT+CGEQMIN 3G quality of service profile (minimum acceptable)
AT+CGEQNEG 3G quality of service profile (negotiated)
AT+CGEQREQ 3G quality of service profile (requested)
AT+CGEREP Packet domain event reporting
AT+CGMI Request manufacturer identification
AT+CGMM Request model identification
AT+CGMR Request revision identification
AT+CGPADDR Show PDP address
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Command Function

AT+CGQMIN Quality of service profile (minimum acceptable)
AT+CGQREQ Quality of service profile (requested)
AT+CGREG GPRS network registration status
AT+CGSMS Select service for MO SMS messages
AT+CGSN Request product serial number identification
AT+CGTFT Traffic flow template

AT+CHLD Call related supplementary services
AT+CHUP Hang-up call

AT+CIMI Request International Mobile Subscriber Identity
AT+CIND Indicator control

AT+CLAC List all available AT commands

AT+CLCC List current calls

AT+CLCK Facility lock

AT+CLIP Calling line identification presentation
AT+CLIR Calling line identification restriction
AT+CMAR Master reset

AT+CMEC Mobile equipment control mode

AT+CMEE Report mobile equipment error

AT+CMER Mobile equipment event reporting
AT+CMGC Send command

AT+CMGD Delete message

AT+CMGF Message format

AT+CMGL List messages

AT+CMGR Read messages

AT+CMGS Send message

AT+CMGW Write message to memory
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Command Function

AT+CMOD Call mode

AT+CMSS Send message from storage
AT+CNMI New message indication to TE
AT+CNUM Subscriber number

AT+COLP Connected line identification presentation
AT+COPN Read operator names
AT+COPS PLMN selection

AT+CPAS Phone activity status

AT+CPBF Find phone book entries
AT+CPBR Read phone book entries
AT+CPBS Select phone book memory storage
AT+CPBW Write phone book entry
AT+CPIN Enter PIN

AT+CPLS Selection of preferred PLMN list
AT+CPMS Preferred message storage
AT+CPOL Preferred PLMN list

AT+CPPS eMLPP subscriptions

AT+CPUC Price per unit and currency table
AT+CPWD Change password

AT+CR Service reporting control
AT+CRC Cellular result codes

AT+CREG Network registration

AT+CRSM Restricted SIM Access
AT+CSCA Service center address
AT+CSCS Select TE character set
AT+CSDF Settings date format
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Command Function

AT+CSIL Silence command

AT+CSMS Select message service

AT+CSOQ Signal quality

AT+CSSN Supplementary service notifications
AT+CSTA Select type of address

AT+CSTF Settings time format

AT+CSVM Set voice mail number

AT+CUSD Unstructured supplementary service data
AT+CAAP Automatic answer for eMLPP Service
AT+FCLASS Select mode

AT+GCAP Request complete capabilities list
AT+GCI Country of Installation

AT+GMI Request manufacturer identification
AT+GMM Request model identification

AT+GMR Request revision identification

AT+GSN Request product serial number identification
AT+ICF DTE DCE character framing

AT+IFC DTE-DCE local flow control

AT+ILRR DTE-DCE local rate reporting

AT+IPR Fixed DTE rate

AT+WS46 PCCA STD-101 [17] select wireless network
AT IBLTH Bluetooth management

AT IBNOTIFY

Control the sending of unsolicited result codes

AT IBTIF Bluetooth configuration
AT IBTINQ Bluetooth inquiry management
AT IGPS GPS location information
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Command Function

AT ILOG Retrieve log file from the EXPLORER™ 500
AT IMETER Call metering

AT INIS Network interface status

AT IPOINT Antenna pointing

AT ISIG Signal quality indication

AT ITCSI Configure incoming voice quality

AT ITCSO Configure outgoing voice quality

AT ITEMP Temperature in the EXPLORER™ 500
AT ITNAT Configure NAT for an interface
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Glossary

A

APN Access Point Name. The Access Point Name is used by the EXPLORER™ 500 user to establish
the connection to the required destination network.

B

BGAN Broadband Global Area Network. A satellite network based on geostationary satellites,
delivering data rates of up to 492 kbps to virtually any part of the earth, with full UMTS (3G)
compatibility.

C

CE Conformitée Européenne. This term signifies that a CE certified product conforms to European
health, environmental, and safety regulations. In short, it makes the product legal to be sold
in the European Union.

D Context IDentifier

D

DHCP Dynamic Host Configuration Protocol. A protocol for assigning dynamic IP addresses to
devices on a network. With dynamic addressing, a device can have a different IP address
every time it connects to the network.

F

FCC Federal Communications Commission. An independent United States government agency,
directly responsible to Congress. FCC certification is normally required to make a product
legal to be sold in the United States.

G

Geostationary  Placed in a fixed position relative to a point on the surface of the earth.

GMPCS Global Mobile Personal Communications by Satellite. GMPCS is a personal communication
system providing transnational, regional or global coverage from satellites.
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GMPCS-MoU

GPRS

GPS

IMEI

IMSO

ISDN

ISP

kbps

LAN

LaunchPad

MAC

A framework signed by Member States, GMPCS System Operators, Terminal Manufacturers
and Service Providers. The GMPCS-MoU mark allows GMPCS subscribers to take terminals
anywhere and use them in countries where they are licensed.

General Packet Radio Service. A standard for wireless communications which runs at speeds
up to 115 kbps, compared with current GSM (Global System for Mobile Communications)
systems’ 9.6 kbps.

Global Positioning System. A system of satellites, computers, and receivers that is able to
determine the latitude and longitude of a receiver on Earth by calculating the time difference
for signals from different satellites to reach the receiver.

International Mobile Equipment Identity. A unique number given to every single piece of
mobile phone equipment. IMEI numbers are stored in a database containing all valid mobile
phone equipment.

International Maritime Satellite Organisation. An intergovernmental body established to
ensure that Inmarsat continues to meet its public service obligations, including obligations
relating to the GMDSS.

Integrated Services Digital Network. An international communications standard for sending
voice, video, and data over digital telephone lines or normal telephone wires. ISDN supports

data transfer rates of 64 kbps.

Internet Service Provider

kilobits per second

Local Area Network. A system that links together electronic office equipment such as
computers and word processors, and forms a network within an office or building.

LaunchPad is a PC application used to control terminals in the BGAN system. LaunchPad is

provided on the Inmarsat CD-ROM supplied with your EXPLORER™ 500. Use of the
LaunchPad is described in the user guide on the CD-ROM.

Media Access Control address. A hardware address that uniquely identifies each node of a
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MDI-X

NAT

NC

P

Pairing

Passkey
PCB

PDA

PDP

PIN

PUK

RSSI

SAS

network.
Medium Dependent Interface. An MDI-X (for MDI crossover) is a version of MDI that enables

connection between like devices. MDI ports connect to MDI-X ports via straight-through
cabling. MDI-to-MDI and MDIX-to-MDIX connections use crossover cabling.

Network Address Translation. An Internet standard that enables a local-area network to use
one set of IP addresses for internal traffic and a second set of addresses for external traffic.
A NAT module makes all necessary address translations.

Not Connected

Bluetooth Pairing happens when two Bluetooth enabled devices agree to communicate. The
two devices exchange passkeys and join what is called a trusted pair. In a trusted pair, the
two devices automatically accept communication with each other.
A unique code or password used when pairing Bluetooth devices.

Printed Circuit Board

Personal Digital Assistant. A lightweight, hand-held, usually pen-based computer used as a
personal organizer.

Packet Data Protocol. A network protocol used by external packet data networks that
communicate with a GPRS network.

Personal Identification Number. A code number used to provide access to a system that has
restricted access.

PIN Unblocking Key. An eight-digit code used to unblock a SIM card after three incorrect PINs
have been entered. The PUK code is supplied with the SIM card.

Received Signal Strength Indicator

Satellite Access Station. The gateway between the satellites and the worldwide networks such
as Internet, telephone network, cellular network etc.
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SDbU

SIM

Streaming

TFT

UDI

USB

VPN

Service Data Unit. Also known as a data packet.

Subscriber Identity Module.The SIM provides secure storing of the key identifying a mobile
phone service subscriber but also subscription information, preferences and storage of text
messages.

A technique for transferring data - such as audio or video clips - so that it is processed as a
continuous stream. With a Streaming connection you are charged by the minute, like for a
telephone connection.

Traffic Flow Template. A packet filter list allowing the Core network and the EXPLORER™ 500
to classify packets received from the external network into the proper PDP context.

Unrestricted Digital Information. A transparent 64 kbps data channel.

Universal Serial Bus. An interface standard for communication between a computer and
external peripherals over an inexpensive cable using biserial transmission. Mostly used with
keyboards, mice, monitors and printers.

Virtual Private Network. A network thatis constructed by using public wires to connect nodes.
You can create networks using the Internet for transporting data, using security mechanisms
so that only authorized users can access the network.
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2-wire interface
connecting, 53
selecting voice quality, 109
specifications, 144

64 kbps UDI using USB, 68

A

accessories available, 127
administration settings, 114
advanced configuration
Bluetooth, 104
LAN, 101
network settings, 110
USB, 99
alarms
in display, 45, 135
list of active, 44, 113
antenna
for Bluetooth, 147
pointing, 23
pole mount kit for, 127
repointing, 39, 81
specifications, 148
APN
setting for all interfaces, 110
setting for Bluetooth, 105
setting for LAN, 101
setting for USB, 99
applications overview, 6
AT commands, 154
audio indicators, 40, 94
audio quality, 51
automatic power up, 41, 93
Azimuth, 21

B
backlightin display, 39, 94

battery
charging, 125
guidelines for use, 125
inserting, 12
removing, 13
specifications, 142
BGAN
coverage, 2
services, &4
system overview, 3
Bluetooth devices
pairing, 50, 106
unpairing, 108
viewing list of paired, 108
Bluetooth handset
charging interface, 72, 150
connecting, 54
making a call, 56
Bluetooth interface
connecting a computer, 69
connecting a handset, 54
setting up, 104
setting voice quality, 104
specifications, 147
browser settings
for web interface, 75

C

call log, 38, 93
call type, 51
calls
holding, 60
local, 59
making or receiving, 56
missed, received, outgoing, 38, 85
redial, 58
to the EXPLORER™ 500, 57
view ongoing, 80
waiting indication, 59
CE compliance, 152
certification, 152
clearing logs, 117
clearing usage counter, 117
common network settings, 110
compliance, 152
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Index

configuration
Bluetooth, 104
exporting to file, 116
import from file, 116
LAN, 101
USB, 99
conformity, 152
connectors
Bluetooth handset charging, 150
external antenna, 149
LAN, 145
overview, 15
Phone/Fax, 144
Power, 143
USB, 146
contact information, 124
contrastin display, 39, 94
coverage
Inmarsat BGAN system, 2

D

dashboard, 79
data
advanced configuration, 110
Profiles, 118
Traffic Flow Templates, 121
data sessions
view ongoing, 80
delivery
items included, 11
DHCP
enable or disable for LAN, 101
display
backlight, 39, 94
contrast, 39, 94
menu drawing, 31
navigating, 34
overview of menus, 30
short-cuts, 34
symbols, 33
disposal, 126
distributors, 124

E

Elevation, 21

Ethernet interface
connecting, 64
setting up, 101
specifications, 145

EXPLORER™ 500
getting to know, 7
type number, ii

export configuration, 116

external antenna, 25

F

fax

sending or receiving, 61
FCC compliance, 152
features, 5
fixed installation, 25

G

general specifications, 141
GMPCS compliance, 152
GPS
antenna, 9
frequency, 148
obtaining GPS fix, 22
position, 42
troubleshooting, 130
view status, 42

H

hardware
view version, 79, 111
Header compression
enable or disable for Bluetooth, 105
enable or disable for LAN, 101
help desk number, 44, 123
changing with web interface, 123

I

IMEI number, 43, 79, 111
import configuration, 116
Inbox for SMS messages
replying, forwarding or deleting, 90
indicators
function, 8
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interfaces
turning on or off, 40, 49
interfaces and services
combinations, 10
internal calls, 59
IP address, 43, 79, 111
ISDN using USB, 68
items included in delivery, 11

L

LAN interface
connecting, 64
setting up, 101
specifications, 145

LaunchPad, 47

LEDs
function, 8

light and sound
disabling, 40, 95

light indicators
function, 8

local phone call, 59

logs
clearing, 117

M

MAC address, 43, 79, 111

matrix of services and interfaces, 10

messages
configuring outgoing, 91
deleting in display, 36
forwarding, 90
opening in display, 36
opening in web interface, 90
receiving in display, 45
receiving in web interface, 89
replying, 90
sending, 89
view list in display, 36

mobile subscriber numbers
viewing, 43,79, 111

NAT
setting on or off for LAN, 101

navigation
display and keypad, 34
web interface, 77
number of EXPLORER™ 500 terminal, ii

0

off-line

working with EXPLORER™ 500, 19
options available, 127
Outbox for SMS messages

resending or deleting messages, 88

P

paired Bluetooth devices
view list, 108
pairing Bluetooth devices, 50, 106
phone
local call, 59
making calls, 56
phone book, 82
add number, 83
delete all entries, 83
delete entry, 83
modify entry, 83
Phone/Fax interface
connecting, 53
selecting voice quality, 109
specifications, 144
PIN
administration PIN, 114
entering in display, 20
entering in web interface, 78
entering with a phone, 55
pointing, 23
help, 21
position data, 21
repoint the antenna, 39
sound on/off, 40, 94
pole mount, 25
POTS interface
connecting, 53
selecting voice quality, 109
specifications, 144
power, 17
automatic, 41, 93
connecting, 16
specifications, 143
power up mode, 41, 93
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Profiles SMS in web interface
for data transmission, 118 forwarding, 90
selecting for Bluetooth, 105 opening, 90
selecting for LAN, 101 receiving, 89
selecting for USB, 99 replying to, 90

properties sending, 89
view, 43,79, 111 SMS service number, 79, 92, 111

Proxy server software
disabling, 75 uploading, 112

PUK code, 20, 55, 78 view version, 79, 111

sound
alarm, 40, 94
Q message, 40, 94

when pointing, 40, 94

quality of voice, 51 sound and light

Quick dial, 56 disabling, 40, 95
specifications
antenna, 148
R Bluetooth handset charging interface, 150
redial. 58 Bluetooth interface, 147

Ethernet interface, 145
general, 141
LAN interface, 145

restoring settings, 41

S Phone/Fax interface, 144
Power, 143

safety summary, iii SIM card, 143

semi-fixed installation, 25 USB interface, 146

sent messages Standard data, 63
resending, forwarding or deleting, 88 start-up
viewing status, 88 options, 18

serial number, 43, 79, 111 status

services methods for signaling, 135
supported by BGAN, 4 viewing, 46, 79

services and interfaces stealth mode
combinations, 10 activating, 34

settings enabling, 40, 95
restore, 41 Streaming data, 63

Short dial, 56 activating, 37, 63

SIM card defining Profiles for, 118
inserting, 12 support
removing, 14 contact information, 124

specifications, 143
SMS in display

opening or deleting, 36 T
receiving, 45 .
view list, 36 telephone interface

connecting, 53
specifications, 144
total usage
viewing, 80, 84
Traffic Flow Templates, 121
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troubleshooting guide, 128
type number of EXPLORER™ 500 terminal, ii

U

UDI using USB, 68
unpairing Bluetooth devices, 108
uploading software, 112
usage counter, 80, 84
clearing, 117
USB interface
connecting, 66
setting up, 99
specifications, 146

V

version
hardware, 43, 79, 111
software, 43,79, 111
voice mail number
viewing, 43, 92
voice quality, 51
selecting for Phone/Fax interface, 109
setting for Bluetooth, 104

W

web interface
accessing, 74
browser settings, 75
definition, 74
navigating, 77

TT 98-122274-M 169



	Safety summary
	Antenna safety instructions
	About this manual
	Introduction
	Welcome
	In this chapter
	The BGAN system
	The BGAN services
	Features and interfaces of the EXPLORER™ 500
	Your EXPLORER™ 500 terminal
	Matrix of services and communication interfaces
	What’s next?

	Getting started
	In this chapter
	Unpacking and assembling
	Connecting cables
	Powering the EXPLORER™ 500
	Options for the start-up procedure
	Entering the SIM PIN
	Pointing the antenna
	Using an external antenna (fixed installation)
	Using a fixed EXPLORER™ 500 (semi-fixed installation)
	Making the first call
	Making the first data connection (LAN)
	What’s next?

	Using the display and keypad
	In this chapter
	Menu overview
	Display during start-up
	Display symbols
	Navigating the display and keypad
	The menus
	Messages menu
	Connect menu
	Calls menu
	Settings menu
	Properties menu
	Help desk
	Dynamic information in the display
	What’s next?

	Using the interfaces
	In this chapter
	General
	Tools for setup and use
	Services and interfaces
	Enabling or disabling an interface

	Bluetooth pairing
	What is pairing?
	Pairing devices in which you can enter a passkey

	Using a phone or fax machine
	Selecting the call type
	Connecting an analog phone or a fax machine
	Connecting a Bluetooth handset
	Entering the SIM PIN using a phone
	Making or receiving a phone call with the EXPLORER™ 500
	Making a call to the EXPLORER™ 500
	Dialing functions
	Sending or receiving a fax message

	Using a computer
	Choosing an interface for data connection
	Standard or Streaming data
	Using the LAN interface
	Using the USB interface
	Using a computer with Bluetooth
	Creating a dial-up connection

	Additional interfaces
	Using an external antenna
	Using the EXPLORER™ Bluetooth Handset charger

	What’s next?

	Using the web interface
	In this chapter
	Introduction
	The web interface
	Accessing and navigating the web interface
	Entering the SIM PIN in the web interface

	The Home window
	Overview
	Terminal properties
	Managing calls and data sessions
	Pointing using web interface

	Using the phone book
	General usage
	Editing phone book entries

	Call log
	Information on total usage
	Exporting the call log
	Viewing the lists of calls

	Handling messages
	Sending an SMS message from the EXPLORER™ 500
	Options for messages in the Outbox
	Options for messages in the Sent folder
	Sending an SMS message to the EXPLORER™ 500
	Receiving a message
	Options for new SMS messages
	Options for SMS messages in the Inbox
	Configuring message settings

	EXPLORER™ 500 settings
	Accessing the EXPLORER™ 500 settings
	Power up behavior
	Setting the display backlight and contrast
	Turning audio indicators on or off
	Enabling activation of stealth mode

	Setting up the interfaces
	Enabling/disabling interfaces
	Description of data settings
	Configuring the USB interface
	Configuring the LAN interface
	Configuring the Bluetooth interface
	Pairing Bluetooth devices from the web interface
	Configuring the Phone/Fax settings
	Setting a common APN

	Properties, software upload and alarm list
	Viewing the properties of the EXPLORER™ 500
	Uploading software
	Viewing the Alarm List

	Administration
	Accessing the administration settings
	Using Profiles
	Using a Traffic Flow Template

	Help desk and diagnostic report
	Accessing the Help desk
	Generating a diagnostic report

	What’s next?

	Maintenance and troubleshooting
	In this chapter
	Getting support
	Uploading software
	Maintenance
	Options and accessories
	Troubleshooting guide
	Status signaling
	Alarm messages
	Log files

	Technical specifications
	In this appendix
	General specifications
	Battery
	Power input
	SIM interface
	Phone/Fax interface
	LAN interface
	USB interface
	Bluetooth interface
	Built-in antenna
	External antenna
	EXPLORER™ Bluetooth Handset charger interface
	Serial number label
	Conformity

	AT commands
	In this appendix
	Starting up an AT command session
	List of supported AT commands

	Glossary
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /AbsoluteColorimetric
  /DetectBlends true
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo true
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Preserve
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /AeroI
    /AeroM
    /Aeromi
    /InfoDispBold-Italic
    /InfoDispBold-Roman
    /InfoDispRegular-Italic
    /InfoDispRegular-Roman
    /Wingdings3
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages false
  /ColorImageDownsampleType /Average
  /ColorImageResolution 2400
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages false
  /GrayImageDownsampleType /Subsample
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages false
  /MonoImageDownsampleType /Subsample
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /FRA <>
    /DEU <>
    /PTB <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /KOR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe7f6e521b5efa76840020005000440046002065876863ff0c5c065305542b66f49ad8768456fe50cf52068fa87387ff0c4ee575284e8e9ad88d2891cf76845370524d6253537030028be5002000500044004600206587686353ef4ee54f7f752800200020004100630072006f00620061007400204e0e002000520065006100640065007200200035002e00300020548c66f49ad87248672c62535f0030028fd94e9b8bbe7f6e89816c425d4c51655b574f533002>
    /CHT <FEFF4f7f752890194e9b8a2d5b9a5efa7acb76840020005000440046002065874ef65305542b8f039ad876845f7150cf89e367905ea6ff0c9069752865bc9ad854c18cea76845370524d521753703002005000440046002065874ef653ef4ee54f7f75280020004100630072006f0062006100740020548c002000520065006100640065007200200035002e0030002053ca66f465b07248672c4f86958b555f300290194e9b8a2d5b9a89816c425d4c51655b57578b3002>
    /DAN <>
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [595.276 841.890]
>> setpagedevice


